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NOTICE

This document is disseminated under the sponsorship of the Department of Transportation in the interest
of,information  exchange. The United States Government assumes no liability for its contents or use
thereof. The United States Government does not endorse products or manufacturers. Trademarks or _
manufacturers’ names appear herein only because they are considered essential to the object of this
document. Arch
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CHAPTER 1. GENERAL 

The documentation for Computer Program COM624P consists of 

three documents: Part I, Users Guide; Part II, Engineering 

Background; and Part III, Systems Maintenance. 

PURPOSE OF TEE USERS GUIDE 

The purpose of Part I of COM624P is to provide detailed 

information to enable the user to employ the program conveniently 

and effectively. The project was conducted under Contract DTHF61- 

88-C-00101 from 1988-1989. The information is presented as 

follows: Chapter 1 introduces the Users Guide and provides system 

background; Chapter 2 summarizes the system in general; Chapter 3 

provides a step-by-step operating procedure; Chapter 4 presents 

input information, names of variables, and data structure for the 

input files; and Chapter 5 presents input and output for examples 

that were studied. 

PROJECT REFERENCES 

The technology on which the program is based has been widely 

used for many years for the analysis of a variety of piles 

subjected to lateral loads. The existing program, COM624, was 

developed at the The University of Texas at Austin and has been 

used on main-frame computers for several years. The project is to 

upgrade COM624 and to develop a user-friendly version for running 

on IBM XT's, AT's, and compatible microcomputers. The first 

version of Program COM624P (Version 1.0) has been used and 

distributed by FHWA since 1990. Because of a number of inquiries 

by design engineers about the ultimate capacity of a pile in 

bending, a subroutine has been added to the current version (2.0) 

to compute the ultimate capacity in bending and the variation of 

flexural rigidity with applied moment. 
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The information shown in the three parts of the documentation 

is limited to that needed for the operation of the computer 

program and to a brief introduction of the method of analysis. 

The user is referred to two documents published by the Federal 

Highway Administration for a relatively complete treatment of the 

topic. The first one is entitled "Behavior of Piles and Pile 
Groups under Lateral Load" (FHWA/RD-85/106). The second one is 
entitled "Handbook on Design of Piles and Drilled Shafts Under 

Lateral Load" (FHWA-IP-84-11). 

SECURITY 

This project is conducted under the sponsorship of the United 

States Department of Transportation. Under the United States 

Copyright Act of 1976, no part of this document or accompanying 

software may be reproduced, translated, or distributed without the 
prior approval of the Department of Transportation. 

No warranty, expressed or implied, is offered either by FHWA 

or Ensoft, Inc., as to the accuracy of results from the program. 

The program should not be used for design unless caution is 

exercised in interpreting the results, and independent 

calculations are available to verify the general correctness of 

the results. The user is assumed to be knowledgeable of the 

information in the documentation that accompanies the diskettes. 

The user is assumed to recognize that the input parameters can 

have a significant effect on the solution and must be chosen 

carefully. 
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CHAPTER 2. SYSTEM SUMMARY AND PROGRAM STRUCTURE 

SYSTEM APPLICATION 

The design of driven piles and drilled shafts under lateral 

loading is an important problem and one that is encountered 

frequently in highway design. The principal use of piles or 

drilled shafts in highway structures is for the support of 

bridges, either to span water courses or to serve in interchanges. 

Other applications using laterally-loaded piles on highways can be 

seen in bridge abutments, overhead signs, pile-supported retaining 

walls, and pile-stabilized slopes. 

Computer program COM624P is used to analyze the behavior of 

piles or drilled shafts which are subjected to lateral loads. The 

method of analysis implemented in COM624P is the so-called p-y 

method. The theoretical background about the p-y method of 

analysis is described in Part II of this document. The digital 

computer allows the deflected shape (lateral deflection) of a pile 

to be computed rapidly and accurately by iteration even though the 

soil reaction against the pile is a nonlinear function of pile 

deflection. After the deflection is determined, the shear, 

bending moment, and soil resistance along the pile can be computed 

thereafter. With the availability of microcomputers, this program 

makes it possible for highway engineers to employ the rational p-y 

method for analysis of laterally-loaded piles and drilled shafts. 

SYSTEM COMPONENTS 

The package sent with COM624P, in general, contains three 

5.25-inch double-sided, double-density floppy diskettes. The 

first diskette contains the main program of COM624P.EXE and six 

sample-data files: Example.INl through Example.ING. The engineer 

may use the sample data to run COM624P and check the solutions 
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presented in Chapter 5. If there are significant discrepancies, 

the user should report to FHWA immediately. 

The second diskette contains the screen-editing files. The 

files stored in this diskette are: C624EDIT.EXE., C624EDIT.HLP, 

C624EDIT.CFG, PILEDATA.LIB, and INSTVIEW.EXE. The engineer may 

use a preprocessor program named C624EDIT.EXE to create a new data 

file, retrieve, and edit an existing data file. 

The third diskette contains the graphics package. The files 

stored in the diskette are C624VIEW.EXE., C624EDIT.CFG, 

INSTVIEW.EXE, and EXAMl.PLT. The main graphics program is named 

C624VIEW.EXE. The user may execute this program and assign the 

data created by COM624P for graphics display. 

SYSTEM PROCESSIWG 

The system consists of three modules as described earlier. To 

process the system, the user starts to load the Menu and selects 

the preprocessor program C624EDIT.EXE to create an input-data 

file. C624EDIT can also be used to retrieve an existing data file 

and to edit the data entry. After the data file has been created 

or corrected, the user should save the data file using the SAVE 

command. 

The second step of processing the system is to call the main 

program COM624P. COM624P will process the data file that contains 

the user's input data, and will create a text-output file and a 

graphics-output file. The user may view the output data on the 

monitor or print the output file to get a hard copy. If the user 

prefers to have a graphics display, then the program C624VIEW 

should be viewed. C624VIEW will display the graphics based on the 

computed results, and the user can get a hard copy of graphics 

from the installed HP plotter or dot-matrix printer. A flow chart 
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depicting data flow and showing the relationships of each module 

is presented in Fig. 2.1. 

SYSTEM CONFIGURATION 

Program COM624P was develaped for the IBM-XT and IBM-AT or 

for any microcomputer that is compatible with the IBM. The 

program has been checked for conformance with ANSI FORTRAN77. The 

Fortran Compiler from Microsoft, Inc., was used to compile the 

source code and create the execution file. 

The word length is important for convergence to a solution 

of the nonlinear equations employed by this program. Therefore, a 

double-precision real value, occupying 8 bytes of storage, was 

used in the Fortran Code. The precision is approximately 15 

decimal digits. If a value has more digits, only the first 15 are 

significant. 

The program requires at least 256k of RAM memory. The math 

coprocessor is highly recommended but is not required. If a high- 

speed, floating-point math coprocessor is installed, the execution 

time for a normal problem is less than one minute. However, it 

can take 3 to 7 minutes for the same problem, depending on the 

type of microcomputer, if the math coprocessor is absent. The 

operating system that is required to run the program should be MS- 

DOS 2.1 or a later version. 

The preprocessor for input data, C624EDIT; and the post- 

processor for graphics display, C624VIEW, were developed in the 

Pascal language to utilize fully the screen-control function 

provided by most microcomputers. Two peripheral devices are 

required to run C624VIEW. One is a graphics adapter which can 

change the screen to the graphics mode for plotting output. 

Currently, the program supports the following graphics adapters: 
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SYSTEM 0 
Prepare Input Data 

C624EDlT.EXE 
Create an Input File 

Run Main Program 
COM624P.EXE 

Create Text Output 81 
Graphics Output 

Send Text Output Process Graphics Data 
to C624VIEW.EXE 

Printer Create Graphics Plots 
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CGA - IBM Color-Graphics Adapter Driver 
EGA - IBM Enhanced-Graphics Adapter Driver 
VGA - Video Graphics Array Adapter 
HERC - Hercules Driver 
AT&T - AT&T 400 Line Driver 

The other peripheral equipment is a printer or plotter for 

hard copies of graphics. The program supports HP plotters; the 

IBM proprinter; Epson MX, FX, LX, LQ or Epson compatible printers 

including Okidata, Panasonic, and Star printers. 

MAIN PROGRAM STRUCTURE 

The structure of the main program COM624P is shown in the 

flow diagram Fig. 2.2. The function of each subprogram is 

described in the following listing. 

1. Main Program 

Function: the main program COM624P inputs and outputs a 
small amount of data, but mainly controls the 
flow of logic by calling appropriate 
subroutines. 

Calls: UNITSS, NODEM INPT, OPIN, NODE, .FLXRIG, DEFLEC, 
ESCALL, DISTR, MCALC, OPCHK, EQUIL, PYGEN, PMEIX 

2. UNITSS 

Function: to store table headings. 

Called 
From: COM624P 

Calls: none 
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START 4 CALL INPUT 

t 
CALL OPIN 

t 

Figure 2.2. The flow chart of Main Program COM624P. 
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3. INPT 

Function: this subroutine reads most of the technical data 
for the problem. 

Called 
From: COM624P 

Calls: none 

4. OPIN 

Function: this subroutine outputs the data for a problem. 

Called 
From: COM624P 

Calls: none 

5. NODE 

Function: this subroutine (1) calculates the coordinate 
for each node, (2) calculates the number of the 
node at the top and bottom of each layer of 
soil, and (3) initializes the array of soil 
moduli. 

Called 
From: COM624P 

Calls: none 

6. FLXRIG 

Function: this subroutine calculates the flexural rigidity 
of the pile at each node. 

Called 
From: COM624P 

Calls: none 
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7. DEFLEC 

Function: 

Called 
By: 

Calls: 

a. DISTR 

Function: 

Called 
By: 

Calls: 

9. MCALC 

Function: 

Called 
By: 

Calls: 

10. OPCHK 

Function: 

Called 
By: 

subroutine DEFLEC calculates deflection at all 
points along the pile. 

COM624P 

none 

this subroutine calculates distributed load 
relevant to each node. 

COM624P 

none 

this subroutine computes the moment, soil 
reaction, and combined stress in the pile at 
each node along the pile. 

COM624P 

FUNCTION D 

this routine calculates the imbalance in force 
and moment at a node. 

COM624P 

Calls: none 
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11. OUTPT 

Function: 

Called 
By: 

Calls: 

12. EQUIL 

Function: 

Called 
By: 

Calls: 

COM624P 

none 

13. INPY 

Function: this subroutine computes values of soil modulus 
from input p-y curves. 

Called 
By: 

Calls: 

ESCALL 

none 

14. FUNCTIONS C, D, GAM, E50, CAVG, AS, AC, SANDAB, PHI 

subroutine OUTPT prints the information from final 
solution, including a table of depth, deflection, 
moment, maximum combined stress in the pile, 
distributed load, soil modulus, and flexural 
rigidity. 

COM624P 

none 

this subroutine (1) computes boundary conditions 
and prints them to facilitate checking and (2) 
computes and prints overall force and moment 
imbalance. 

Functions: these function subroutines do the following: 

FUNCTION C computes the value of cohesion at any depth by 
linear interpolation from input data. 

FUNCTION D computes the pile diameter at any depth. 

FUNCTION GAM computes the average effective unit weight of 
soil above a point. 
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FUNCTION ES0 computes the & 50 (strain at a stress ratio of 
50 percent) by linear interpolation from input 
data. 

FUNCTION CAVG computes the average shear strength of soil 
above a point, 

FUNCTION AS computes the coefficient A, for stiff clay 
below the water table. 

FUNCTION AC computes the coefficient A, for stiff clay 
below the water table. 

FUNCTION SANDAB computes coefficients A and B for sand. 

FUNCTION PHI computes angle of internal friction at any 
depth. 

Called 
By: these functions are called in the subroutines 

that generate p-y curves (SOFTCL, STIFFA, 
STIFFB, and SAND). 

Calls: none 

15. PYGEN 

Function: this subroutine reads information needed to 
generate p-y curves, stores data for each layer, 
and calls ESCALL to generate p-y curves. 

Called 
By: COM624P 

Calls: ESCALL 

16. ESCALL 

Function: subroutine ESCALL calls the appropriate 
subroutine for calculation of soil modulus or 
generation of p-y curves for verification 
purposes. 

Called 
By: COM624P, PYGEN 

Calls: SOFTCL, STIFFB, STIFFA, SAND, INPY 
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17. SOFTCL 

Function: this subroutine generates p-y curves for output 
verification and calculates secant soil modulus 
at all nodes in soil with KSOIL = 1 (internally- 
generated p-y curves in soft clay with Matlock's 
(1970) recommendations). 

Called I 
By: ESCALL 

Calls: Functions D, C, GAM, ES0 

18. STIFFB 

Function: this subroutine generates p-y curves for 
verification of output and calculates secant soil 
modulus at all relevant nodes where KSOIL = 2 
(stiff clay below the water table with criteria by 
Reese et al., 1975). 

Called 
By: ESCALL 

Calls: Functions D, C, CAVG, GAM, E50, AS, AC 

19. SAND 

Function: this subroutine generates p-y curves for 
verification of output and calculates secant soil 
modulus at all relevant nodes where KSOIL = 4 
(internally-generated p-y curves in sand with 
criteria by Reese et al., 1974). 

Called 
By: ESCALL 

Calls: Functions D, GAM, PHI 
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20. STIFFA 

Function: this subroutine generates p-y curves for 
verification of output and calculates secant soil 
modulus at all relevant nodes when KSOIL = 3. 

Called 
By: ESCALL 

Calls: Functions D, C, CAVG, GAM, and E50 

21. ROCK 

Function: this subroutine generates p-y curves for 
verification of output and calculates secant soil 
modulus at all relevant nodes where KSOIL = 6 
(internally-generated p-y curves in rock with 
limestone criteria by Reese and Nyman, 1978). 

Called 
By: ESCALL 

Calls: Functions, D, C, CAVG, GAM, E50 

22. LAYERS 

Function: this subroutine calculates the equivalent 
thickness of soil layers for use in the theory for 
the behavior of layered soil. 

Called 
By: SOFTCL, STIFFB, STIFFA SAND , 

Calls: none. 

23. PMEIX 

Function: this subroutine calculates the ultimate bending 
capacity and variation of flexural rigidity based 
on given data on cross section. 

Called 
By: COM624P 

Calls: SETUP, CSTRES, STEELP, SHELLP, SHELLM, COREP, 
COREM. 
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CHAPTER 3. GUIDE FOR EXECUTION OF COM624P 
ON A MICROCOMPUTER 

COM624P was written with user-friendly features such as menu 

input, free-field format, and screen editing. The output can be 

sent to printers for hard-copy or sent to plotters for display Of 

graphics. This section describes the step-by-step procedures t0 

operate the system. 

Operation of COM624P consists of three steps. The first step 
is the creation of input-data files using the user friendly input 

menus or an ASCII input batch file using a text editor. After an 
input file has been created execute the program by selecting the 

"Run w menu or typing COM624P.EXE for batch file execution. The 
procedures for each step are described in the following 
paragraphs. 

BACKING UP AND RESTORING ORIGINAL DISKETTE 

The user is assumed to have basic knowledge on how to use the 

operating system (DOS) for selected microcomputers. Before 

operating, a backup copy should be made for each original diskette 

and the original diskettes should be stored in a safe place. 

To make a backup of the entire diskette, the user can use the 

following steps: 

1. Format a regular blank floppy diskette using the FORMAT 

command on the DOS operation system. 

2. Insert the original diskette in Drive A, and the 

formatted diskette in Drive B, then enter the following: 
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A:> COPY A:*.* B: <CR> 

(Note: <CR> represents the enter or return key) 

3. If the user has a hard disk installed in the computer, 

use the following instructions to create a COM624P directory and 

save all the files onto the hard disk: 

c:> MD COM624P <CR> 

(Note: create a directory) 

C:> CD COM624P <CR> 

(Note: change main directory to COM624P directory) 

C:\COM624P>COPY A:*.* <CR> 

(Note: copy files from the original diskette in Drive A to 

the hard disk in Drive C) 

GUIDE FOR INSTALLATION OF CONFIGURATION FILE 

The program named INSTVIEW.EXE is used to create the 

configuration file used for video attributes and graphics drivers. 

The file produced by INSTVIEW is named C624EDIT.CFG. The 

configuration file must be kept on the same disk directory that 

contains C624EDIT.EXE and C624VIEW.EXE. 

If these files are on Drive C, then enter the following: 

C:\COM624P>INSTVIEW.EXE <CR> 
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INSTVIEW will begin and will ask the user to make selections 

regarding units of data, graphics hardware, Graphics Mode, and 

video attributes. The following sections discuss the information 

requested by INSTVIEW. 

The first input screen presented by INSTVIEW is the values 

for control parameters denoted by COM624P. The default values are 
provided as shown in the following. The user can change the 
preset values, if it is necessary. For example, an input value of 
2 for units will cause COM624P to display SI units instead of 

English units When the user is satisfied with the selection, the 

F8 key should be pressed to continue to the selection of the 

graphics driver and Graphics Mode. 

C624EDiT Configuration File Editor 

-Units, 1 = lb&inch, 2 = metric, 3 = other 
p-y Curve Criteria: 0 = cyclic, 1 = static i 
Print full pile response: 0 = off, 1 = on 
Print p-y curves: 0 = off, 1 = on . . . . . . . . . i 
Iterations Limit for Analysis . . . . . . . . . . . . . 100 
Convergence tolerance for pile analysis . . . 0.000100 
Back-up data files: 0 = off, 1 = on . . . . . . 1 
Pile Property Library Path & Name . . . . . . . . B:PILEDATA.LIB 

A 1:DEF:Num 1 

: Move Cell - ? : Help - F2 : Edit Cell - F8 : Continue - d 
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The second input screen presented by INSTVIEW is the menu 

from which the graphics driver is selected. The graphics drivers 
that are supported are: 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 

CGA 

MCGA 

EGA (256K memory version) 

EGA (64K memory version) 

EGA driving monochrome monitors 

VGA 

IBM 8514 

AT&T 

(9) Hercules monochrome 

(10) IBM PC3270 

Graphics Drivers 

(1) Color Graphics Adapter (CGA) 
(2) MCGA 
(3) 16 Color Enhanced Graphics Adapter 
(4) 4-Color Enhanced Graphics Adapter 
(5) EGA driving Monochrome Display 
(6) IBM-8514 Graphics Card 
(7) Hercules Monochrome Graphics Adapter 
(8) AT&T 400-Line Graphics Adapter 
(9) Virtual Graphics Array (VGA) 
(10) IBM PC3270 Graphics 

(11) Accept this selection 

Current Selection is VGA 

Enter new selection: 11 

All of the above graphics drivers, with the exception of the 

IBM PC3270 and Hercules monochrome, can be driven in a variety of 

modes. After the graphics driver has been selected, a third input 
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screen is presented for the selection of the Graphics Mode. - The 
Graphics Mode controls the combination of pixel densities and 

colors used by COM624P. 

, 

Graphics Modes for VGA 

(1) 640x200 16-Color 
(2) 640x350 16-Color 
(3) 640x480 16-Color 

(4) Accept this selection', 

Current Selection is 0) 

Enter new selection: 4 

The next screen is to specify plotting-control values and the 

printing device in the system, as shown below. It should be noted 

that all the printer output will be sent to port LPTl. If the 

setup in the system is different, the user can use DOS MODE 

command to redirect the printer port. 

I I 
Optional Plotting Control Values 

Axis Title Character Size (IN) . . . . . . . . . . . . . . 
Plotting Symbol Size (IN) . . . . . . . . . . . . . . . . . . . 
Plotter Pen Number for Axis Titles . . . . . . . . . . 
Plotter ,Pen Number for Axis and Borders . . . . . 
Plotter Pen Number for Data Line & Symbols . . 
Type of Printer Used for Screen Dump . . . . . . . . 
Codes for printers: 1 = Epson MX, FX 

:: 
= Epson LQ 
= Toshiba 24-pin 

4 = HP LaserJet and DeskJet 
5 = HP InkJet 
6 = IBM Proprinter 
7 = IBM Proprinter 

0.15000 
0.15000 

i 

t 

All printer output is sent to LPTl. 
To redirect LPTl to COMl use the DOS MODE command. 

A 1:DEF:Nwn I- 0.15000 

: Move Cell - 7 : Help - F2 : Edit Cell - F8 : Continue -I 
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The final input screen presented by INSTVIEW is the 

interactive selection of the video attributes used in the screen 

menus. The user may use this feature to customize the colors used 

by Menu to suit his or her personal tastes. Five video attributes 

may be selected. They are the color schemes used on Menu 

backgrounds, the highlighted letter choices, the current Menu 

selections and the data-entry cells (both active and inactive). 

This interactive section shows an example of the current 

selections so that the user can appraise the selections and avoid 

confusing combinations of color. Users running the program on 
systems with monochrome monitors have a smaller range of 
selections, but still have a wide variety of possible selections. 

Selections for the video attributes are made by moving the 

box to the desired combination of letter color and background 

color, then by pressing the appropriate Function Key (Keys Fl 

through F5). The user may change any of the selections as 
desired. The user then presses the Escape Key when satisfied with 

the current selections for the video attributes. 

The last step of the installation process is for the user to 

indicate acceptance of the current configuration for COM624P. If 

the user is satisfied, 'Y' or 'y' should be entered for yes. If a 

'yes I response is given, COM624P will write the new version of 

C624EDIT to the current directory and indicate that it has been 

changed. If the user enters an answer other than 'yes', the 

program exits without saving a new configuration file. 

20 

Arch
ive

d



MENU STRUCTURE 

COM624P, Version 2.0, uses the window feature and pull-down- 
menu interface for easy learning and operation. Figure 3.1 shows 
the complete structure of COM624P's Main Menu and its successive 

pull-down menus. 

The main function of the File Menu is for assigning files for 

input, output, and graphical data. The "Input" Menu will call up 
Module C624EDIT which consists of four sub-menus. The sub-menu 
named "Analysis" in C624EDIT is for entering data that are needed 

for computation of a pile under lateral loading. The sub-menu 
named "MuIt" is for entering data that are needed for computing 

the ultimate bending moment and EI-values for the selected-pile 

section. Because Module C624EDIT also can be used as a stand- 
alone program, the "File" sub-menu is provided for reading and 

saving of the data files. The "Option" sub-menu mainly provides 

the user an easy way for changing parameters on configuration. 

The "Run" Menu will call up Module COM624P for execution, 

using the specified files for input and output. The "Graphics" 

Menu will call up Module C624VIEW, which consists of four sub- 

menus. The sub-menu "File" under the Graphics Menu is needed only 

if the Module C624VIEW is used as a stand-alone program. If a 

file name for graphical data has been given earlier, the program 

will automatically use that file for producing graphical results. 

The sub-menu named "View" is for generating graphics on the screen 

for preview. The sub-menu named "Plot" is for generating HP-GL 

plotting files for high-quality pen plotters. The sub-menu 

"Option" is provided for changing the parameters on configuration. 

The detailed discussion of each menu will be presented later in 

this chapter. 
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Figure 3.1. Main menu structure of COM624P. 
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GUIDE FOR USING MAINMENU 

The MAINMENU.BAT file is a special batch file that will 

integrate all the modules needed for operation of COM624P in the 

DOS environment. The shell process was used so that the computer 

will automatically transfer control to the appropriate module, 

based on the given command. 

To initiate the program, the user enters 

C:\COM624P>MAINMENU <CR> 

The program will quickly bring up the Main Menu on the Screen. 

The Main Menu has four choices: File, Input, Run, and Graphics. 

File Input Run Graphics 

This program is developed especially for Design and analysis 
of piles under lateral loading. The current version is 2.0 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as assigning input file, 
output file, and graphics file, reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. 

The selection of INPUT menu allows the user to access Program 
C624EDIT to create a data file or to edit an existing data file. 

The selection of the RUN menu allows the user to execute the 
program with the specified input and output files. 

The selection of the GRAPHICS menu allows the user to view the 
soil and pile response curves directly on the screen. The 
system must have graphics adapters such as CGA, EGA, VGA, or 
monographics adapter in order to view the graphics. 

Fl-Help Alt-X-Exit 

Once the Main Menu has been called, an item can be selected 

by pressing the key corresponding to the first letter in the name 

of the menu. The arrow keys can also be used to move the 

highlight bar and Enter can be pressed when the bar is at the 

appropriate command. 
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The selection of the File Menu allows the user to access a 

pull-down menu for file operations such as assigning an input 

file, output file, and graphics file, reading an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. 

The selection of the Input Menu changes the screen from the 

Main Menu to the Input Menu as shown in Figure 3.1. The selection 
of the Run Menu allows the user to execute the program with the 

specified files for input and output. The selection of the 
Graphics Menu changes the screen from the Main Menu to the 

Graphics Menu as shown in Fig. 3.1. 

The first step is to select the File Menu. Once the File 
Menu has been pulled down, the hot keys for the Up arrow and the 
Down arrow can be used to highlight the desired command. 

File Input Run Graphics 

Graphic File 

Fl-Help Alt-X-Exit 
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The user needs to specify a Input, Output, and Graphics file 

before selecting the Input, Run or Graphics Menu. 
File Input Run Graphics 

Read File Name 
EXAMPLE.INl 

I 

Fl-Help Alt-X-Exit 

GUIDE FOR USING INPUT MENU 

Once you select the "INPUT** from the Main Menu, the Input 

Menu will be shown on the screen as in the following. 
File Analysis Mult Option 

C624EDIT 2.0, Edit Variables: 

This program is a preprocessor developed especially for users 
for preparation of input for the computer program COM624P. The 
main menu for this program is displayed as a bar at the top 
row of the screen. The main menu has four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The selection of the ANALYSIS menu allows the 
user to enter required data for computing the response of the pile 
and soil, such as distributions of deflection, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile size for computing the ultimate bending moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
for most computer systems. 

Fl-Help Alt-X-Exit 
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The Input Menu has four submenus: File, Analysis, MULT, and 

Option. The four menus allow the user to access file operations, 

data editing, control of variables in the analysis, and program 

options. If help is needed for data entry, the FI key is pressed 

to access the help files. 

The user can move from one choice to another by using either 

the arrow keys or by typing the highlighted letter of the choice. 

Thus, if the File selection is currently highlighted (and the File 

pull-down menu is not shown), one may move to the Analysis 

selection by either typing the right-arrow key twice or by typing 

'A' or 'at for Analysis. 

The File Submenu presented under the "Input" menu provides 

additional access to the commands for the control of input files. 

This menu controls reading of input files, creation of new input 

files, saving of files, examining the contents of any 
subdirectory, changing of directories, and exiting the program at 

the conclusion of use. 

If the user has already specified the file name for the input 

data under the Main Menu, they need not give the file name here; 

however, if the input file was not specified previously, the 

selection of llFile" will allow you to enter the file name again. 

To access the file menu, you need to move the highlighted bar to 

the "File" and press <Enter>. The options under the File submenu 

will be shown on the screen as the following. 

The File pull-down menu commands are: 

Read - to read data files, 
New - to create a new data file, 
Save - to save the current data as a disk file, 
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Directory - to display disk directories, 
Change Dir - to switch subdirectories, 
Exit to DOS - to leave the program, and 
Main - to return to the Main Menu. 

File Analysis 

Read 
New 
Save 

-n 

Directory 
Change dir 
Quit to DOS 
Main Menu 

Mult Option 

Fl-Help Alt-X-Exit 

For example, to retrieve an existing input file named EXAMPLE.IN6, 

you can move the cursor to highlight "Read" on the submenu and 

press <Enter>. The screen will have a window for the user to 

enter the file name as shown below. 

File Analyaio m1t option 

New File Nanw New File Nanw 
EXAMPLE.INb EXAMPLE.INb 

I I 

Fl-Help Alt-X-Exit 
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Once the input file is found, the program will read line by line 

from the file and the data will be echoed on the screen. 

File Analysis Mult Option 
Reading EXAMPLE.IN6 

Line #lo: 30.0000 30.0000 14906.0000 707.0000 
Line X10: 160.0000 30.0000 47813.0000 707.0000 
Line X11: 1 4 0.0000 360.0000 90.0000 
Line #12: 0.0000 0.06900 
Line #12: 360.0000 0.06900 
Line #13: 0.0000 0.0000 38.0000 0.00000 
Line #13: 360.0000 0.0000 38.0000 0.00000 
Line #17: 
Line #18: 2~.0000 
Line X18: 60.0000 
Line #18: 100.0000 
Line #18: 150.0000 
Line #19: 1 
Line #20: 1 60000.0000 0.0000 50000.0000 
Line X21: 
Line #22: 5o;oo.o~ 
Line #23: 3500.00 60000.00 0.00 29000000.00 
Line #24: 0.00 30.00 0.00 0.00 0.00 
Line #25: 8 12 0 3.0000 
Press any key to continue . . . . . 

Fl-Help Alt-X-Exit 

If there is an error in retrieving data, a message will be given 

on the screen, The user should note the cause of the error and 

press the <Enter> key to continue. Most of the errors have to do 

with the format of input' data. The user should check the line 

number and make the correction later on the Edit screen. 

After the editing of the input data is completed, the user 

needs to save the new data by moving the cursor to "Save" and 

pressing <Enter> after the "Save" was highlighted. A window will 

allow the user to give a file name for the new data as shown in 

the following. 

The user can press "M" and then <Enter> to return to the initial 

Input Menu. 
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File Analysis Mult Option 

Read 1 New 
Save 

Save File Name 
EXAMPLE.IN7 

!ain Menu 
I 

] 

Fl-Help Alt-X-Exit 

The Analysis Submenu opens access to edit the various data 

groups defining the problem. Variables that may be edited through 

this submenu are title for the problem, pile properties, soil 

properties, load-transfer data, data for loading, computation 

control and output format. 

File Analysis Mult Option 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

Fl-Help Alt-X-Exit 
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The Analysis pull-down menu commands are: 

Title - to edit the program title, 
Pile Properties - to edit the pile properties (length, 

diameter, cross-sectional area, and EI), 
Soil Properties - to edit the soil properties (layers, 

strength parameters, unit weights, etc.), 
Load-Transfer - to edit the user-specified p-y curves, 
Data for Loading - to edit loads at the top of the pile and 

the distributed load, 
Computation Control - to select the tolerance and iteration 

numbers for computation, 
Output Tables - to select options for printing output data, 

and 
Main - to return to Main Menu. 

The user can select any one of the items shown in the 

Analysis submenu to review, create, or change the data. Some of 

the variables for input may use an abbreviated name because of the 

limited space available on the editing window. However, all 

variables will have a full, detailed explanation in the help file. 

It should also be noted that all the x-coordinates described by 

the program are based on the origin which is set at the top of the 

pile. If help is needed for data entry, the user can press the 

"Fl" key to access the help file, and press the "FS" to return to 

the edit screen. 

The screens that are used to create data for EXAMPLE.IN6 are 

presented in the following to illustrate the usage of the Analysis 

submenu. 
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File Analysis Mult Option 

C624EDIT 2.0, Edit Variables: 

This program is a preprocessor developed especially for users 
for preparation of input for the computer program coM624P. The 
main menu for this Program is displayed as a bar at the top 
row of the screen. The main menu has four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The selection of the ANALYSIS menu allows the 
user to enter required data for computing the response of the pile 
and soil, such as distributions of deflection, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile size for computing the ultimate bending moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
for most computer systems. 

I I 
Fl-Help Alt-X-Exit 

File Analysis Mult Option 

Title -- 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

Fl-Help Alt-X-Exit 

Move the cursor to "Title", then press <Enter> key; the 
following screen will appear. 
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File Analysis Mult Option EXAMPLE.IN6 

Enter title for this data file (up to 72 characters long) 

EXAMPLE 6 ANALYSES RELATED TO DESIGN OF CONCRETE PILES 

A 1:DEF:Lab EXAMPLE 6 ANALYSES RELATED TO DESIGN OF CONCRETE PILES L : Move Cell - ? : Help - / : Edit Screen----- F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key: [FBI l 

File 
.C 

/  

1 

Analysis Mult 

Title 
Pile Properties- 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

Option 

Fl-Help Alt-X-Exit 

Move the cursor to "Pile Properties*', then press <Enter> key; 
the following screen will appear. 

32 

Arch
ive

d



File Analysis Mult Option EXAMPLE.IN6 

Editing Pile Dimensions 

Number of increments (<= 300) ..................... 100 
Distance from top of pile to ground surface - inches 0.0 
Length of pile .............................. inches 360.00 
Pile modulus ................................ psi 3200000 
Slope of ground surface (degrees) ................. 0.0000 

A 1:DEF:Num L 100 

: Move Cell - 
Fl-Help Alt-X-Exit? 

: Help - / : Edit Screen--- F8 : Continue - 

Press Command Key: [F81. 

File Analysis Mult Option EXAMPLE.IN6 

Editing Pile Section Properties 

Section Top Depth Diameter Mom. of Inert. Area 

f 
inches inches inches**4 inches' 

0.00 30.000 47813.0000 707.0000 
2 30.00 30.000 14906.0000 707.0000 
3 160.00 30.000 47813.0000 707.0000 
4 

ii 
7 
8 
9 

10 

To access pile property library leave pile diameter blank. 

A 1:DEF:Num 0.00000 L l Move Cell - 
Fl-Help' 

? : Help - / : Edit Screen- F8 : Continue 1 
Alt-X-Exit 

Press Command Key [Fl] or "?" for help, the screen on next page 
will appear. 
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File Analysis Mult Option 
I I 

Help Topics 

Mult MENU Edit - 
Mult - Shape and Axial Loads 

Computation Control 
Edit - 

Mult - 
Mult - 

&bar & Concrete Strength FILE MENU 
Output Tables 

Section Dimension File - Read 
Mult - Rebar Arrangement File - New 

EDIT MENU File - Save 
Edit - Title File - Write 
Edit - Pile Properties- File - 
Edit - Soil Properties 

Directory 
File - 

Edit - Soil - p-y Criteria 
Change Directory 

File - Exit to DOS 
Edit - Soil - 
Edit 

k for Clays MAIN MENU 
- Soil - k for Sands Main - Pull-down Menus 

Edit - Soil - E50 Main - 
Edit - Soil - 

Hot Keys 
OPTIONS MENU 

Edit 
p-y Multipliers 

- Soil - Unit Weights 
Edit 

Options - Units 
- Lat. Load Trans. 

Edit - Data for Loading ~',~::: 
- Pile Property Library 
- Save Config. File 

Options - Auto-backup 

Fl-Help Alt-X-Exit 

Move the cursor to "Pile Properties" and press <Enter>; the 
following screen will appear. 

File Analysis Mult Option 
* 

The maximum number of increments allowed into which the pile is 
divided is 300. Typically the user will have selected the number of 
increments to be equal to some multiple of the overall pile length, 
so that the output values are calculated uniformly with depth. 

Piles can have several different segments but each one is treated 
as a uniform cross section. For taper piles, the program allows 
the user to use up to 10 uniform segments to model the properties. 
"Top Depth" shown in Editing Pile Section Properties is the x-coord. 
(depth below the top of pile) of the top of a segment of pile with 
uniform cross section. 

For frequent designers if the pile diameter is set equal to zero, 
the user gains access to a library file defining pile properties. L The 
pile property library is created separately by the user for his own 
use. 

--I 

If the units of the data in the pile property library are dif- 
ferent from those set inside C624EDIT, a units conversion is performed 

Fl : Help Index - PageUp PageDown - F8 : Return 
Fl-Help Alt-X-Exit 

Press Command Key [F8] to return to the Edit Menu. 
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File Analysis Mult Option EXAMPLE.IN6 

Editing Pile Section Properties 

Section Top Depth Diameter Mom. Of Inert. Area 

: 
inches inches inches**4 inches' 

0.00 30.000 47813.0000 707.0000 
2 30.00 30.000 14906.0000 707.0000 
i 160.00 30.000 47813.0000 707.0000 

: 
7 
8 

1x 

To access pile property library leave pile diameter blank. 

A 1:DEF:Num 0.00000 L : Move Cell - ? : Help - / : Edit Screen F8 : Continue 2 
Fl-Help Alt-X-Exit 

Press Command Key: fF81. 

File Analysis Mult 

Title 
Pile Properties 
Soil Properties4 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

J 

Option 

Fl-Help Alt-X-Exit 

Move the cursor to "Soil Properties", then press <Enter>; the 
following screen will appear. 
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File Analysis Mult Option EXAMFLE.IN6 

Editing Soil Layer Information 

Layer Criteria x-top X-bot k 

r 
# inches inches lb/in3 

0.00 360.00 90.00 
2 i 360.00 540.00 500.00 

: 
5 

4 

i 
10 

p-y Curve Criteria 
= Soft Clay Criteria #3 = 

Stiff clay Below Watertable 
Stiff Clay Above Watertable 

= Sand 
= Interp. Between Input Curves :t = Vuggy Limestone 

D 2:DEF:Num 500.00000 L : Move Cell - 3 : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key [F8] to continue. 

File Analysis Mult Option FJ@MF'LE.IN6 

Editing Effective Unit Weight Information 

Point 

r 
2 

: 

z 
7 

i 
10 

Depth 
inches 

0.00 
360.00 

360.00 540.00 

Unit Weight 
lb/in3 

0.069 
0.069 

0.034 0.034 

A 4:DEF:Num 540.00000 L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key [F8] to continue. 
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File Analysis Mult Option EXAMPLE.IN6 

Editing Shear Strength Information 

Layer Depth C 
n inches 

ES0 
psi de:. @ 50% of c 

5 360.00 0.00 0.000 38.00 0.0000 
0.000 

3 
38.00 

360.00 
0.0000 

10.000 0.00 
4 540.00 

0.0050 
10.000 0.00 

5 
0.0050 

t 

A 4:DEF:Num 540.00000 

: Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key EF8l. 

File Analysis Mult option 

Title 
,Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu t 

Fl-Help Alt-X-Exit 

Move the cursor to "Data for Loading", then press <Enter>; the 
following screen will appear. 
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File Analysis Mult Option EXAMPLE.IN6 

Editing Loading Information 

Distributed lateral loading (y/n) 7 ............... n 
Is loading cyclic (y/n) ? ......................... n 
Boundary condition code (KBC) ..................... 1 

KBC = 1 for shear and moment (free head) 
KBC = 2 for shear and slope (fixed head) 

EE 
= 3 for shear and rotational restraint (partially fixed) 
= 4 for deflection and moment 

A l:DEF:Lab n L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue 1 
Fl-Help Alt-X-Exit 

Press Command Key [F8] to continue. 

File Analysis Mult Option EXAMPLE.IN6 

Editing Pile-head Loading 

KOP Shear Moment Axial Load 
pounds in-lbs pounds 

1 20000.00 0.000 50000.00 
1 40000.00 0.000 50000.00 

KOP=O if only a summary output for this load to be printed 
=l if complete output is desired for this load 

A ~:DEF:NuIII 1 L : Move Cell - ? : Help - / : Edit Scree v F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key [F8], 
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File Analysis 

r 
Mult Option 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control-ti 
Output Tables 
Main Menu 

1. Maximum number of iterations allowed for analysis : 100 
2. Tolerance on solution convergence, inches : 0.000010 
3. Value of deflection considered to be excessive, inches : 147.0000 
4. Computation using internally-generated cracked EI (Y/N : N 
Note: If the above answer is Y, remeber to enter the same 

axial load and other parameters such as arrangement 
of rebar, concrete and rebar strength in the WJLT" 
menu later. 

Fl-Help Alt-X-Exit 

Move the cursor to "Computation Control", then press <Enter>; 
the following screen will appear. 

File Analysis Mult Option EXAMPLE.IN6 
I 

I A 1:DEF:Num 100 
J l- : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 

Fl-Help Alt-X-Exit 

Press Command Key [F8] (if needed, press the [F-l] key to access 
the Help File for an explanation of cracked/untracked EI) l 
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File Analysis Mult 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables- 
Main Menu 

Option 

Fl-Help Alt-X-Exit 

Move the cursor to "Output Tables," then press <Enter>; the 
following screen will appear. 

File Analysis Mult Option EXAMPLE.IN6 

Output Printing Options 

I *** Lateral Load Analysis *** 

Printing Increment (1 for every node, 2 for every other node, etc) 1 
Print deflection, moment, shear over full length of pile (y/n) Y 
Print p-y curves for verification Y 

A 1:DEF:Num 1 L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key: LF81. 
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The MULT Submenu opens access to the editing commands for 

ultimate-bending moment computation. Variables edited through 

this menu are the title for computation, cross-sectional shape, 

axial loads, strength of materials, dimensions of cross section, 

and rebar measurement. The user can pull down the MULT submenu by 

moving the highlighted bar to "MULTW and press <Enter> after the 

initial Input Menu is returned to the screen as shown below. 

File Analysis Mult Option EXAMPLE.IN6 

Title 
Cross Section Shipe 
Axial Loads . 
Strength of Materials 
Dimension of Cross SeCtiOn 
Rebar Arrangement 
Main Menu 

Fl-Help Alt-X-Exit 

The MULT pull-down menu commands are: 

Title - to edit the program title, 
Cross-section Shape - to select the shape of the cross 
section, 
Axial Loads - to enter the values of axial loads that are 

considered, 
Strength of Materials - to enter the yield strength and the 

elastic modulus, 
Dimension of Cross Section - to enter the dimensions for 

specified cross section, 
Rebar Arrangement - to enter the rebar size, rebar number and 

arrangement, and 
Main - to return to Main Menu. 
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If the user would like to compute the ultimate bending moment 

of the pile or ask the program to generate cracked/untracked 

bending stiffness used for deflection computation, input data 

should be provided for each item under the MULT submenu. If 

cracked EI is chosen for the computation, the axial load entered 

in the "Data for Loading" submenu of the "Analysis" menu should be 

consistent with the axial load used in the "MultV1 submenu for each 

case. If help is needed for data entry, the user can press "Fl" 

key to access the help file and then press the "F8" key to return 

to the previous screen. 

The screens that are needed to create data for EXAMPLE.ING 

are presented in the following screens to illustrate the usage of 

the MULT menu. 

File Analysis Mult Option 

Title 
Cross Section Shaped 
Axial Loads 
Strength of Materials 
Dimension of Cross Section 
Rebar Arrangement 
Main Menu 

Fl-Help Alt-X-Exit 
Press Command Key: [Cl * 

42 

Arch
ive

d



File Analysis Mult Option EXAMPLE.IN6 

Identification number of the shape of cross section 
of the pile: 

1: Rectangular or square; 
2: Circular (without shell or core); 
3: Circular (with shell but without core); 
4: Circular (with shell and core); 
5: Circular steel pipe; 

Enter the number: 2 

A l:DEF:Num L 2 

: Move Cell - ? : Help - / : Edit Screen- FE : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key: [F81 

File Analysis Mult option 

Title 
Cross Section Shape 
Axial Loads- 
Strength of Materials 
Dimension of Cross Sectiol 
Rebar Arrangement 
Main Menu 

EXAMPLE.IN6 

Fl-Help Alt-X-Exit 

press Command Key: [Al 
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Analysis Option EXAMPLE.IN6 

Enter axial loads for cross section design: 

Point Loads pounds 

1 
2 

50000.00 

If the cracked EI will be used in computation of the pile deflection, 
the field will show the same axial load given in the "Analysis" menu. 

A 1:DEF:Num 50000.00000 

: Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Commar,d Key: 

File Analysis 

IF81 

Mult Option EXAMPLE.IN6 

Dimension of Cross Section 
Rebar Arrangement 
Main Menu 

Fl-Help Alt-X-Exit 

rress Command Key: Sl 
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File Analysis Mult Option EXAMPLE.IN6 

I 
Enter strength parameters of materials 
---------_---------------------------- 

Cylinder strength of concrete psi 3500.00000 
Yield strength of reinforcement psi 60000.00000 
yield strength of shell or core psi 0.00000 
Modulus of elasticity of steel psi 29000000.00000 

A ~:DEF:NuIII 3500.00000000 L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

Press Command Key: [F~I 

File Analysis Mult Option 

Title 
Cross Section Shape 
Axial Loads * 
Strength of Materials 
Dimension of Cross Section 
Rebar Arrangement 
Main Menu 

l J 1 
RXAMPLE.IN6 

Fl-Help Alt-X-Exit 

Press Command Key: [Dl 
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File Analysis Mult Option EXAMPLE.INC 

Enter cross-section dimension 
--------------_----_--------- 

Width of section (rectangular section only) inches 0.00000 
Depth of section (rectangular section only) inches 0.00000 
outer diameter (circular section only) inches 30.00000 
Outer diameter of core (circular section only) inches 0.00000 
Thickness of shell (circular section only) inches 0.00000 
Thickness of core (circular section only) inches 0.00000 

A 1:DEF:Num 0.00000000 

: Move Cell - 3 : Help - I : Edit Screen- F8 : Continue 1 
Fl-Help Alt-X-Exit 

Press Command Key: 

File Analysis 

[F81 

Mult Option EXAMPLE.IN6 

Title 
Cross Section Shape 
Axial Loads * 
Strength of Materials 
Dimension of Cross Section 
Rebar Arrangement 
Main Menu 

Fl-Help Alt-X-Exit 

r.r e = .s command Key: LRJ 
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File Analysis Mult Option EXAMPLE.IN6 

Rebar Arrangement 

Size of the rebar (enter the bar number, 3, 5, 8, 9...) 8 
Number of reinforcing bars 12 
Number of rows of reinforcing bars (rectangular section only) 0 
Cover of rebar (from center of rebar to outer edge 3.0000 
of concrete) inches 

A 1:DEF:Num 8 L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue 1 
Fl-Help Alt-X-Exit 

Press Command Key: I~83 

File Analysis Mult Option EXAMPLE.IN6 

Title 
Cross Section Shape 
Axial Loads 
Strength of Materials 
Dimension of Cross SeCtiOn 
Rebar Arrangement 
Main Menu- 

Fl-Help Alt-X-Exit 

Press Command Key: [Ml 
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File Analysis Mult 

C624EDIT 2.0, Edit Variables: 

Option 

This program is a preprocessor developed especially for users 
for preparation of input for the computer program COM624P. 
main menu for this program is displayed as a bar at the top 

The 

row of the screen. The main menu has four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The selection of the ANALYSIS menu allows the 
user to enter reguired data for computing the response of the pile 
and soil, such as distributions of deflection, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile size for computing the ultimate bending moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
for most computer systems. 

I 
Fl-Help Alt-X-Exit 

Press Command Key: IF1 

File Analysis Mult Option 

Fl-Help Alt-X-Exit 

Press Command Key: [Sl 
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The Options Submenu provides a path for the user to the 
commands that control where C624EDIT looks for a library file, for 

pile properties, and to save the current Analysis variables in the 

configuration file. The procedure for accessing the Options pull- 

down menu is no different than for the other menus. The user can 
move the cursor to "Options" and press <Enter>. The following 

information will be shown on your screen. 

File Analysis Mult Option 

?igggzq 

Fl-Help Alt-X-Exit 

The Options pull-down menu commands are: 

Units - to select units for computation, 
Library Directory - to change the name of the subdirectory 

containing the pile-properties library, 
Save Configuration File - to save the current values of the 

Analysis and Options variables to the configuration 
file, 

Auto Backup - a toggle switch to enable the automatic 
backing up of any file read by C624EDIT.EXE, so that 
the file may be saved under its original name. The 
backup-file name will be the original file name with a 
file extension of 'lBAK,ll and 

Main - to return to the Main Menu. 
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COM624P can perform calculations in pounds and inches (Option l), 

kilonewtons and meters (Option 2), or any consistent set on units 

(Option 3) for force and length. The user should take care that 
all input values are entered in consistent units. The following 
screen will illustrate how to select the units that the user 

requires. 

File Analysis Mult Option 

Fl-Help Alt-X-Exit 

In many cases, a user may want to try several different sizes 

of piles, which can be a standard steel section or a non-standard 

reinforced concrete section, for the preliminary studies. The 

pile-library file is a data-base file in which the user can store 

data for most commonly-used pile sections. This file will be 

automatically loaded into the computer memory each time the user 

calls the Input Menu. 

The pile-library file is associated with the section for 

editing pile properties in Module C624EDIT. The pile-library data 

will be presented on the screen for selection if the user leaves 
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blank the entry fields for pile diameter, moment of inertia, and 

area during the editing process. 

The name of the file under which,C624EDIT looks for the pile 

property library can have up to 42 characters. The user should be 

sure to enter the full name of the pile property library file, 

including the disk drive letter and path. The following screens 

will illustrate how to select the new pile property library. 
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File Ana1ySi.S Mult Option 

Editing Pile Section Properties 
I 

Section Top Depth Diameter Mom. of Inert. Area 

: 
inches inches inches**4 inches' 

0.00 
2 240.00 

: 

2 
7 
8 
9 

10 

To access pile property library leave pile diameter blank. 

A 2:DEF:Num 240.00000 

: Move Cell - ? : Help - / : Edit Screen- F8 : Continue I 4 
Fl-Help Alt-X-Exit 

Leave blank for all fields except for "Top Depth", then press 
[F81 key. 

File Analysis Mult Option 

Pile Section 1 - Top Depth = 0.00 inches 

Select Appropriate Pile Type 

HP 14x117, Axis x-x 
HP 14x117 Axis Y-Y 
HP 14x102, Axis X-X- 
HP 14x102, Axis Y-Y 
HP 14x89, Axis X-X 
HP 14x89, Axis Y-Y 
HP 14x73, Axis X-X 
HP 14x73, Axis Y-Y 
HP 12x74, Axis x-x 
HP 12x74, Axis Y-Y 

FX=A FY=3 Page = 0 Library entry 3 

I 

Fl-Help Alt-X-Exit 

Move the cursor to the selection for the first pile segment, 
then press <Enter>. 
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File Analysis Mult Option 

Pile Section 2 - Top Depth = 240.00 inches 

Select Appropriate Pile Type 

HP 14x117, Axis X-X 
HP 14x117 Axis Y-Y 
HP 14x102, Axis X-X 
HP 14x102, Axis Y-Y 
HP 14x89, Axis x-x 
HP 14x89, Axis Y-Y 
HP 14x73, Axis X-X- 
HP 14x73, Axis Y-Y 
HP 12x74, Axis X-X 
HP 12x74, Axis Y-Y 

FX=A FY=7 Page = 0 Library entry 7 

Fl-Help Alt-X-Exit 

Move the cursor to the selection for the second segment, then 
press <Enter>. 

File Analysis Mult option 

Editing Pile Section Properties 

Section 

! 
2 
3 

Top Depth Diameter Mom. of Inert. Area 
inches inches inches**4 inches' 

0.00 14.030 1050.0000 30.0000 
240.00 13.640 734.0000 21.5000 

4 
5 

7" 
8 
9 

10 

To access pile property library leave pile diameter blank. 

A 1:DEF:Num 0.00000 L : Move Cell - 3 : Help - / : Edit Scrcen- F8 : Continue I 
Fl-Help Alt-X-Exit 

The selection from the pile-library is shown on the above 
screen. 
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The format for pile-library data is quite straightforward. 

There are two lines of input reserved for each size of pile. The 

first line is used for the description of the pile section such as 

"HP 14 x 73, Y-Y Axis". The second line consists of five entry 

fields. The first entry is the I.D. for units. For English Units 

"1" is entered, and "2" is entered for S.I. units. The second 

entry on Line 2 is the diameter or width of the section 

perpendicular to the direction of loading. The third entry on 

Line 2 is the value of the moment of inertia. The fourth entry on 

Line 2 is the cross-sectional area. The last entry is the modulus 

of elasticity for the section. The free-field format is used for 

the entry. The user can use any text editor to add or delete the 

data in the pile-library file. 

When a selection is made from the Analysis or Mult Submenus, 

a data-entry-worksheet display appears on the screen. The data 

that have been entered are shown in a spreadsheet-type 

arrangement. 

The data-entry worksheet screen, as shown in Fig. 3.2, 

contains three main sections: 

1. The top line of the screen display is the Main Menu 
with 'Edit' highlighted. 

2. The data-entry worksheet section consists of two 
boxes, a large box about 18 lines high followed by a 
small box about two lines high. 

3. The bottom two lines of the display contain a 
guide to some of the 'key assignments' for 
commands to use with the data-entry worksheet. 
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WI 
ul 

File Analysis Mult option EXAMPLE.IN6 -Top Line 

Editing Shear Strength Information 

Layer Depth ES0 
# inches PST de:. e 50% 0f c 

2’ 360.00 0.00 0.000 0.000 38.00 38.00 0.0000 0.0000 

: 

: 
7 

i 
10 

A 1:DEF:Num 0.00000 

: Move Cell - ? : Help - / : Edit Screen---- F8 : Continue - 
Fl-Help Alt-X-Exit 

-Large box for 
data entry 

Small box for 
-data entry 

-Key Assignment 

Figure 3.2. Data-entry worksheet. 
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The data-entry worksheet, Section 2, is the most important 

part of the display, and the section where all of the data-entry 

operations will take place. 

The upper, and largest, box of the worksheet section of the 

screen display contains the data that have been entered. These 

data are in a spreadsheet-type arrangement; that is, in columns, 
designated alphabetically from left to right, and in rowsl 

designated numerically from top to bottom. A location, designated 

by a column letter and a row number, is called a cell and each 

item of data is stored in one of these cells. By using the 

cursor-movement commands, a highlight can be moved in any 

direction from the upper left cell to the lower right cell. The 

highlighted cell is called the 'working cell'. A cell must be 

highlighted - the working cell - for data to be entered or edited. 
The data in an existing file, shown on the worksheet, can be 

manipulated to some extent by using the Worksheet Edit commands 

that will be described later. 

The lower box of the worksheet section of the display is 

where data are entered into the working cell, or the existing data 

is edited. This box has two lines. The upper line shows the 

following information for the working cell: 

Location - column letter and row number, 
Status - UND means the cell is not defined as a part of 

the data and DEF means the cell has been 
defined to contain data, and 

Data - the data type [Num for numeric and Lab(labe1) 
for alphanumeric] followed by the existing 
data in the cell. 

The bottom line of the lower box is the 'Entry Line' where 

data entry or data editing are done. A blinking cursor is shown 

on this line. Data are typed by moving the cursor to the right. 

Only the Backspace key, however, may be used for corrections to 
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the typed data; the Backspace key is used to move the cursor back 

(without canceling the typed symbols) to where a correction is to 

be made, and then the correct data are overtyped. The Enter 
(Return) key is used to accept edited data as the data in the 

working cell. 

If the information in the working cell requires editing, two 

methods may be used. The simplest way is merely to reenter the 

data. The other way is to enter the Cell Edit Mode by pressing 

the F2 key. Editing in this mode will be explained later. The 

key assignments in the bottom two lines of the display, Section 3, 

change to show Cell Edit commands. These commands are used to 

make the desired modifications to the data in a cell. Pressing 

Enter (Return) will exit the Edit Mode and also replace the 

existing data in the working cell with the edited data. 

There are three sets of commands to be used with a data-entry 

worksheet. These are the Basic Worksheet Commands, the Cell Edit 

Commands, and the Worksheet Edit Commands. The Basic Worksheet 

Commands are in effect when a data-entry worksheet is entered. 

The other two sets of commands are invoked from the Basic 

Worksheet Commands. A key assignment in the form of '"(key)' may 

be found in the command sets. To obtain this key assignment, the 

'Cntl' and the second key are pressed at the same time. For 

example, ^A is obtained by pressing <Cntl> and <A> at the same 

time. The key assignments for the various sets of commands are 

given in the following paragraphs. 

These commands are in effect when a display of a data-entry 

worksheet is on the screen, except when either of the other two 
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command sets has been invoked and is in use. The key assignments 

for some, but not all, of these commands are shown in the bottom 

two lines, Section 3, of the screen display. The key assignments 

for the commands in this set are as follows: 

Left Arrow Move highlight one cell to the left 

Right Arrow Move highlight one cell to the right 

Up Arrow Move highlight up one cell 

Down Arrow Move highlight down one cell 

Page Up Move up one page (if more than one page) 

Page Down Move down one page (if more than one page) 

F2 

Return (Enter) 

Enter Cell-Edit Mode 

Accept data entered or edited, exit Cell- 
Edit Mode 

/ 

FB 

Enter Worksheet-Edit Mode 

Return to Edit Menu or move to next 
worksheet for current menu item 

End 

? or Fl 

Return to Main Menu 

Enter Help Mode 

The preceding commands are all self-explanatory except for 
“F2 II - Enter Cell - Edit Mode and V/I1 - Enter Worksheet - Edit 

Mode, which will be described in detail in the next two sections. 
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The following screens illustrate the procedures for calling 

the help file during data entry. It should be noted that the help 

file is a simple text file to which the user can add his/her own 

comments or notes at desirable locations. The user can open the 

help file named C624EDID.HLP by using any available text editor. 

The help file, however, always needs to stay in the same file 

directory with C624EDIT.EXE. 

File Analysis Mult Option E2CAMPLE.IN6 

Editing Shear Strength Information 

Layer Depth 
# inches p*: de;. * 

ES0 
e 50% of c 

1 0.00 0.000 38.00 0.0000 
I: 360.00 0.000 38.00 0.0000 

4 

z 
7 
8 
9 

10 

4. 1:DEF:Num 0.00000 

: Move Cell - 3 : Help - / : Edit Screen F8 : Continue + 
Fl-Help Alt-X-Exit 

The help topics will be shown on the screen once the "Fl" or 

"?I' keys have been pressed. You can move the cursor to the 

desired topics and press <Enter> to bring the help instruction on 

to the screen. 
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File Analysis Mult Option 

Help Topics 

Mult MENU 
Mult - Shape and Axial Loads 
Mult - 
Mult - 

Rebar & Concrete Strength 
Section Dimension 

Mult - Rebar Arrangement 
EDIT MRNU 

Edit - Title 
Edit - Pile Properties 
Edit - Soil Properties 
Edit - Soil - 
Edit 

p-y Criteria 
- Soil - 

Edit 
k for Clays 

- Soil - k for Sands 
Edit - Soil - ESO- 
Edit - Soil - 
Edit 

p-y Multipliers 
- Soil - 

Edit - 
Unit Weights 

Lat. Load Trans. 
Edit - Data for Loading 

Edit - Computation Control 
Edit - Output Tables 

FILE MRNU 
File - Read 
File - New 
File - Save 
File - Write 
File - Directory 
File - Change Directory 
File - Exit to DOS 

MAIN MENU 
Main - Pull-down Menus 
Main - Hot Keys 

OPTIONS MENU 
Options - Units 
Options - Pile Property Library 
Options - Save Config. File 
Options - Auto-backup 

Fl-Help Alt-X-Exit 

Move the cursor to the "E50", then press <Enter>. 

File Analysis Mult Option EXAMPLE.IN6 

Soil Strain Parameter ES0 

Soft Clay, c = 1.74 to 3.47 psi 
250 to 500 psf 

12 to 24 KPa 

Medium Clay, c = 3.47 to 6.94 psi 
500 to 1000 psf 

24 to 48 KPa 

Stiff Clay, c = 6.94 to 13.9 psi 
1000 to 2000 psf 

48 to 96 KPa 

Very Stiff Clay, c = 13.9 to 27.8 psi 
2000 to 4000 psf 

96 to 192 KPa 

ES0 = 0.02 

ES0 = 0.01 

ES0 = 0.007 

ES0 = 0.005 

- Fl : Help Index - 
Fl-Help 

PageUp PageDown - F8 
Alt-X-Exit 

: Return - 

Press Command Key [F8] to return. 
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The Cell-Edit Mode is used to make changes and additions to 

the data in the working cell, and is entered by typing the F2 key. 

When this key is pressed, a highlighted bar will appear on the 

line between the two worksheet boxes as shown in the following. 

File Analysis Mult Option EXAMPLE.IN6 

Enter title for this data file (up to 72 characters long) 

EXAMPLE 6 ANALYSES RELATED TO DESIGN OF CONCRETE PILES 

Edit Mode Overwrite 
R l:DEF:Lab EXAMPLE 6 ANALYSES RELATED TO DESIGN OF CONCRETE PILES 
EXAMPLE 6 #;LY$ES RELATED TO DESIGN OF CONCRETE PILES 

F : Move Cursor Insert/Delete/-G A 
Fl-Help Alt-X-Exit 

The highlighted bar contains 'Edit Mode' and an indication that 

the data entry is in the 'Insert' or the 'Overwrite' condition. 

Two general types of commands are available, cursor-movement 

commands and data-change commands. The key assignments for the 

Cell-Edit Mode are displayed in the bottom two lines, Section 3, 

of the screen. 

Left Arrow Move cursor on the entry line to the 
left 
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Right Arrow 

"A 

Move cursor on the entry line to the 
right 

Move cursor to beginning of the entry 
line 

^F Move cursor to end of the entry line 

Insert Toggles between 'Insert' and 'Overtype' 
for data entry 

Del Deletes character to the left of the 
cursor 

^G Deletes character at the cursor 

Return (Enter) Accepts data on the entry line and exits 
Cell-Edit Mode 

The following screens illustrate how to use the above 

commands for changing the data. 

File Analysis Mult Option EXAMPLE.IN6 

Enter title for this data file (up to 72 characters long) 

EXAMPLE 6 ANALYSES RELATED TO DESIGN OF CONCRETE PILES 

Edit Mode Insert On 
b 1:DEF:Lab EXAMPLE 6 ANALYSES RELATED TO DESIGN OF CONCRETE PILES 
XAMPLE 6 ANU$Y$ES RELATED TO DESIGN OF REINFORCED CONC- PILES 

F : Move Cursor Insert/Delete/ G - 
Fl-Help Alt-X-Exit 

Press the rrIns81 key to change to insert mode for the edited cell, 

then add the word "Reinforced" before the word "Concrete" as shown 

in the next screen. 
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File Analysis Mult optiori EXAMPLE.IN6 

Enter title for this data file (UP to 72 characters long) 

EXAMPLE 6 ANALYSES RELATED TO DESIGN OF REINFORCED CONCRETE PILES 

A 1:DEF:Lab EXAMPLE 6 ANALYSES RELATED TO DESIGN OF REINFORCED CONCRETE PILES 

: Move Cell - 7 : Help - / : Edit Screen- F8 : Continue " 
Fl-Help Alt-X-Exit 

The Worksheet-Edit Mode is used to manipulate entire lines of 

data in the worksheet. It is invoked by typing I/' from the 

Basic-Worksheet-Command list. When the I/' is typed, a 
highlighted bar appears on the line between the two worksheet 

boxes, and a list of possible operations appears in the 

highlighted bar as shown in the following. 

File Analysis Mult Option EXAMPLE.IN6 

Editing Pile Section Properties 

Section Top Depth Diameter Mom. of Inert. Area 

: 
inches inches inches**4 inches' 

0.00 30.000 47813.0000 707.0000 
2 30.00 30.000 14906.0000 707.0000 
3 160.00 30.000 47813.0000 707.0000 

ii 
6 
7 

10 

To access pile property library leave pile diameter blank. 

Blank Copy Delete Exchange Insert Move 
A 1:DEF:Num 0.00000 

z Move Cell - 3 t Help - / : Edit Screen- F8 : Continue --L--- 
Fl-Help Alt-X-Exit 
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A I/' also appears on the entry line of the lower box. To 

complete the command, the first letter of the choice from the list 

of possible operations is typed on the entry line; in addition, 

some answers to prompts on the entry line may have to be typed. 

After the selected operation is complete, the program returns to 

the Basic-Worksheet-Command Mode. The following operations are 

available: 

/B(lank) 

/C(opy) 

/D(elete) 

/E(xchange) 

/I(nsert) 

/M(ove) 

ESC(ape) 

Erase current row and set all cells on the row to 
UND (undefined) status 

Copies contents of first row specified to 
second row specified 

Deletes current row and moves up following 
rows 

Exchanges contents between first row specified 
and second row specified 

Inserts blank row where specified and moves 
following rows down 

Moves contents of first row specified to second 
row specified and adjusts contents of 
intermediate rows so no data are lost 

Exits Worksheet-Edit Mode without performing 
any operation 

The following screens are presented to illustrate the 

procedures for copying and deleting one row of data. For copying 

data, type "C" in the lower box of the edit screen, then tell the 

program to copy data from Row 2 to Row 4 as shown below. 
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File Analysis Mult Option EXAMPLE.IN6 

Editing Pile Section Properties 

Section Top Depth Diameter Mom. of Inert. 
x inches 

Area 
inches inches**4 

; 30.00 0.00 
inches' 

30.000 30.000 47813.0000 707.0000 
14906.0000 

3 160.00 
707.0000 

30.000 47813.0000 
4 

707.0000 

2 
7 
8 
9 

To access pile property library leave pile diameter blank. 

Blank Copy Delete Exchange Insert Move 

Fl-Help 
: Help - / : Edit Screen- F8 : 

Alt-X-Exit 
Continue - 

Press <Enter> after the command is given, you will see the data 

from Row 2 are also presented in Row 4. 

File Analysis Mult Option EXAMPLE.IN6 

Section 

! 
2 
3 

ii 

! 
8 
9 

10 

Editing Pile Section Properties 

Top Depth Diameter Mom. of Inert. Area 
inches inches inches**4 inches' 

0.00 30.000 47813.0000 707.0000 
30.00 30.000 14906.0000 707.0000 

160.00 30.000 47813.0000 707.0000 
30.00 30.000 14906.0000 707.0000 

To access pile property library leave pile diameter blank. 

4 1:DEF:Num 0.00000 

- : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 
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If the user decides to erase Row 4, the user need to press the "/" 
key first, then type "D" in the lower box of the edit screen. The 

screen will ask the user to specify a row number as shown below. 

File Analysis Mult Option EXAMPLE.IN6 

Editing Pile Section Properties 

Section Top Depth Diameter Mom. of Inert. Area 

i! 
inches inches inches**4 inches' 

0.00 30.000 47813.0000 707.0000 
2 30.00 30.000 14906.0000 707.0000 
3 160.00 30.000 47813.0000 707.0000 
4 30.00 30.000 14906.0000 707.0000 

65 
7 
8 
9 

10 

To access pile property library leave pile diameter blank. 

Fl-Help 
I 

Alt-X-Exit 

Press the <Enter> key, the user will find data on Row 4 are 
removed as presented in the following screen. 

File Analysis Mult Option EXAMPLE.IN6 

Editing Pile Section Properties 

Section Top Depth Diameter Mom. of Inert. Area 

i! 
inches inches inches**4 inches1 

0.00 30.000 47813.0000 707.0000 
2 30.00 30.000 14906.0000 707.0000 
3 160.00 30.000 47813.0000 707.0000 

: 

4 
8 

1: 

To access pile property library leave pile diameter blank. 

A 1:DEF:Num 0.00000 L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 
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GUIDE FOR RUNNING MAIN PROGRAM (COM624P) 

After an input file has been created and saved on the same 

directory, press the <ALT> and <X> keys simultaneously to exit the 

Input screen and return to the original Main Menu as shown below. 

To execute the program, the user should move the cursor to "Run" 

as shown on the top of the screen and press <Enter>. A normal run 
will end in less than one minute if a math-coprocessor is 
installed. The text output and graphics data will be created and 

saved to the previously specified files, respectively. If an 
unexpected result is encountered, the program will stop running 
and an error message will be shown on the screen. Then, the user 

should check the input data carefully. If Module COM624P is used 
as a stand-alone program, make sure to erase the file named 

"COMFILE.DAT" if it exists in the same directory. This file is a 
temporary file to be used for the shell process. 

File Input Run- Graphics 

This program is developed especially for Design and analysis 
of piles under lateral loading. The current version is 2.0 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as assigning input file, 
output file, and graphics file, reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. 

The selection of INPUT menu allows the user to access Program 
C624EDIT to create a data file or to edit an existing data file. 

The selection of the RUN menu allows the user to execute the 
program with the specified input and output files. 

The selection of the GRAPHICS menu allows the user to view the 
soil and pile response curves directly on the screen. The 
system must have graphics adapters such as CGA, EGA, VGA, or 
monographics adapter in order to view the graphics. 

Fl-Help Alt-X-Exit 
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GUIDE FOR OPERATING GRAPHICS POSTPROCESSOR (C624VIEW) 

After a successful run, the graphics data will be saved to 
the specified file. The user can move the cursor to "Graphics" 
shown on the top of the Main Menu and press <Enter> to open the 

graphics window. 

File Input Run Graphics + 

This program is developed especially for Design and analysis 
of piles under lateral loading. The current version is 2.0 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as assigning input file, 
output file, and graphics file, reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. 

The selection of INPUT menu allows the user to access Program 
C624EDIT to create a data file or to edit an existing data file. 

The selection of the RUN menu allows the user to execute the 
program with the specified input and output files. 

The selection of the GRAPHICS menu allows the user to view the 
soil and pile response curves directly on the screen. The 
system must have graphics adapters such as CGA, EGA, VGA, or 
monographics adapter in order to view the graphics. 

Fl-Help Alt-X-Exit 

The graphics window with pull-down menu is designed for 
C624VIEW. The configuration file, C624EDIT.CFG, must be on the 
same disk directory that contains C624VIEW.EXE. If there is no 
plot shown on the screen after the graphics data have been read 

in, the user may need to again run the installation program 

INSTVIEW.EXE, described in a previous section, to specify the 

correct screen driver for the program. The detailed procedures 

for using C624VIEW to obtain graphics will be presented in the 

following section. 

The driver supports the IBM color-graphics adapter (CGA), IBM 

enhanced color-graphics adapter (EGA), Hercules graphics boards 

and video-graphics array (VGA) . The graphics adapters and 
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printers supported by this graphics package are listed in Table 

3.1. The distributor will not be responsible for modifying the 

software for use on any graphics adapter or printer not listed or 

not compatible to those listed in Table 3.1. The graphics program 
is easy to use and the procedures will be illustrated in this 

section. 

TABLE 3.1. DRIVER INFORMATION FOR 
GRAPHICS ADAPTERS AND PRINTERS 

GRAPHICS ADAPTERS 
IBM Color-Graphics Adapter (CGA) 
IBM Enhanced-Graphics Adapter (EGA) 
IBM PC3270 
Hercules Monochrome 
AT&T Indigenous Graphics Board 
IBM Video-Graphics Array (VGA) 

PRINTERS 
Epson MX, FX, LX-80, 100, Okidata, 

Panasonic, and Star Gemini 
Epson LQ 
IBM Proprinter 
Hewlett Packard Laser Jet and Desk Jet 
Hewlett Packard Pen Plotter 

The Graphics Menu is displayed on the top line of the screen. 

This menu has four submenus: File, Select, View, and Options. Any 

of these selections may be chosen by highlighting the selection 

using the cursor keys or by typing the first letter of the 

selection ("V" for View, etc.) 

When the Graphics Menu is active, a status report is 

displayed on the screen below the Main Menu. This report shows 

the number and size of any data sets stored currently in the 

microcomputer's memory and indicates what data sets are currently 

selected for viewing. 
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File View Plot Options 

C624VIEW Version 2.0, Graphics Data: 
Number of p-y curves: NumPYcurve = 4 
Number of load-response curves: NumCurves = 2 
Number of point on load-response curves: Npts = 99 
Units are Pounds & Inches 
p-y Curves selected for viewing 

Response Curves selected for viewing 

277520 bytes available 
Largest block contains 277520 bytes 

The graphics data file is PLOTDATA 

Alt-X Exit 
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The File Menu is used to read files of graphics data, show 

the current subdirectory, change the logged subdirectory, or quit 

the program and return to the disk-operating system. The 
selections in the File Menu are: 

Read- to enter the name of the file to be read. If the file 
does not exist or is empty, a diagnostic message is 
displayed, 

Directors - to display the directory of the current sub- 
directory, 

- to change the logged subdirectory, 

Quit- to quit UPVIEW and return to DOS, and 

Main - to return to the Main Menu. 

If the user has already specified in the Main Menu the file 

name for the graphics data, the program will automatically read 

and display it on the screen. However, if the user would like to 

view the graphics under other file names, then the user can move 

the cursor to "Readl@ and type the new file name as shown below. 
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File View Plot Options 

Read 
Directory 

-u 

Change dir 
Quit to DOS 
Main Menu 

Alt-X Exit 

Move the cursor to the "Readgl, then press <Enter>. 

File View Plot Options 

Read File Name 

Alt-X Exit 
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The View Menu is used to select the data sets to view under 

the View option. The selections on the View Menu are: 

g-v Curves - to select individual p-y curves for viewing. To 
select a p-y curve, the user tabs down to the desired 
curve using the cursor keys, then presses the space bar. 
An asterisk will mark any p-y curve to be displayed. 
Pressing the space bar a second time will turn off the 
selection. Finally, F8 is pressed to return to the 
Select Menu. 

ResDonse Curves - to select individual curves for viewing 
that show the response of the pile. Pile-response 
curves are selected in the same manner as p-y curves, 

Ultimate-Moment Curves - to select curves of moment versus 
curvature or curves of flexural rigidity (EI) versus 
moment for different axial-loading cases. 

Interact'on Diagram - to select the interaction diagram 
(uliimate moment vs. axial load). In order to view the 

diagram, the user must have selected at least three 
different axial loads for computation. 

View Curves - to display the selected curves and to dump the 
graphics on the screen, and 

Meu - to return to the Main Menu. 

The user can type WIV1l or move the cursor to "View," then press the 

<Enter> key to pull down the View Menu. 

The p-y curves are displayed first (if selected), followed by 

the pile-response curves for deflection, moment, shear, and soil 

reaction, and followed by the moment-curvature curve, the EI- 

moment curve, and the interaction diagram. The user clears the 

display by pressing the <Enter> key. 
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File View Plot 

p-y Curves 
Response Curves 
Ultimate Moment 

El 

Interaction Diagram 
View Curves 
Main Menu 

Options 

Alt-X Exit 

A dump of the graphics from the screen is possible to any 

Epson dot-matrix, IBM or HP laser jet, or any compatible printing 

device. The dump is triggered by pressing the Control and "P" 

keys simultaneously. The user can specify the type of printer 

during installation or specify the printer in the Options submenu. 

If no printer is connected or is turned off, the program will lock 

until the printer is made available. 

The following screens will illustrate the procedures to view 

each graphic. Be sure to follow the instructional commands which 

are printed directly below each screen for practice. 
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Option8 File View Plot 

p-y Curves - 
Response Curves 
iUltimate Moment 
Interactive Diagram 
View Curves 
Main Menu 

Alt-X Exit 

Press Command Key: IPI l 

File View Plot Options 

Selection of p-y Curves for Viewing 

Number Depth 

ON 1 20.00 
ON 2 60.00 
ON 3 100.00 
ON 4 150.00 

Alt-X Exit 

Toggle Viewing of Curves ON/off Using Space Bar- 

F8 : Continue 

Press Command Key: [I?81 l 
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Plot Options 

Alt-X Exit 
Press Command Key: [RI l 

File Vi8W Plot Options 

Selection of Response Curves for Viewing 

Number Deflection Nonmnt Shear Soil Reaction 

1 ON ON off off 

Toggle Viewing of Curves ON/off Using Space Bar+ 

F8 : Continue 
Alt-X Exit 

Press Command Key: [FBI l 
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File view Plot 

p-y Curves 
Response Curves 
Ultimate Moment +- 
Interactive Diagram 
View Curves 
Main Menu 

ontions 

Alt-X Exit 
Press Command Key: WI  l 

File View Plot Options 

Selection of Moment, Curvature and EI Curves for Viewing 

Number 

t 
3 

Moment vs Curvature EI vs Moment 

ON ON 
off off 
off off 

Toggle Viewing of Curves ON/off Using Space Bar 

L F8 : Continue 
Alt-X Exit 

Press Command Key: LF81. 
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File view Plot OPtions 

lp-y Curves 
‘Responre Curves 
Ultimate Moment 
,Interactive Diagram 
'View Curves 
Main Menu c 

Alt-X Exit 
Press Command Key: [II l 

File View Plot Options 

Selection of Curves Under Various Axial Loads for Viewing 

Number Axial Load 

ON 1 0.00 
ON 2 100.00 
ON 3 1000.00 

Toggle Viewing of Curves ON/off Using Space Bar 

F8 : Continue 
Alt-X Exit 

Press commana hey: fF83. 
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File View Plot Options 

Response Curves 
Ultimate Moment 
Interactive Diagram 
View Curves 

AIC:-X Ex1.t 

Press Command Key: WI l 

0.0 0.5 1 .o 1.5 2.0 2.5 a.0 a.5 

: : : : : : : 

9.0 smo -.,.. i ..:... . . . ..I...................i.........i...................~........l.........~........~.........~........~....... 

: ; : ; : : 
: f : 

: : 
; : 

: : : : I : : 
: : 

8.0 8.0 r . . ..i.............. ..:.,.......;.,..._ i 
i 

. . . . . . . ..>....... 
: 

i.........i.........~........,j,..,.....~.........;.........~......... 
: : 

-::. : : : : : : .:. ,: : 
: : : : : 

7.0 7.0 -.,......... . :. ..(_. . . . . . . . . . . . . . . ..L.........................~..................~.........~........~....... 
e : : 

i : : 
: : 

: : : : : : 

i 
1 
J 
" 
Q 

l 20 otiu .lUU v 150 PLOTDRTII Cnt1-P to Print Scrmn 
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-0.05 0.00 0.05 0.10 

:  :  :  

:  :  :  

:  i i i 

__. .  . j . .  . ! .  . ! .  

:  :  :  ;  

:  

4.0 5 
: 

i :  

: 
:  :  

,,.,; ._._,..,.: . . . .._.... . . . . . . . . . . . . .._. i . . . . . . . . . . 
-:::: 
- : : : : ., ; 
-::I::: 

4.5 5 : : : . . . . . . . . . . . . . . . . . . . . . ..~.........~........~.........~...... 
-:: j:;; 
-:.:: 

5.0 r 
: : 

0.0 

0.s 

1.0 

; 

f 

P.S 

: 9.0 

f a.s 

PLOTOWl 

Itmnsnt <Inch-Yios> <looo-s~ 

0.0 0.s 1.0 

...... 

...... 

...... 

...... 

...... 

Cdl-P to prtnt term 

Cdl-P to PrAnt tcrmal 
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1.00 

curvrturr co. oool’ s> 

2.00 2.00 4.00 s.00 

2.4 

20.0 

18.0 

16.0 

14.0 

12.0 

cntn-P to Print term 

1.0 2.0 2.0 4.0 5.0 6.0 

: : : : 
10.0 . . . ..-.....'.... 

: 
: : 

8.0 1: ! . . . . . f 
: : 
: : 

8.0 I...! . . . . . . . . . . . . 

4.0 

2.0 

0.0 

: : : : : : : f : : : 
: : : : : : : : : 

Cdl-P to Print term 
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6.0 6.0 7.0 7.0 0.0 0.0 9.0 9.0 

,,,:,,,,, ,,,,l,,,, 

0.0 

7.0 

6.0 

5.0 

4.0 

3.0 

2.0 

: : : 

F+LOTOMA 

- 
cdl-P to Print term 
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The Plot Submenu is used to select the sets of data and to 

prepare the files on graphics for HP-plotters or plotter 

emulators. The selections in the Plot Menu are: 

p-y Cm - to select individual p-y curves for viewing. To 
select a p-y curve, the user tabs down to the desired 
curve using the cursor keys, then presses the space bar. 
An asterisk will mark any p-y curve to be displayed. If 
the space bar is pressed a second time, the selection 
will be eliminated. Returning to the Select Menu is 
accomplished by pressing F8. 

Response CurveS - to select individual curves for viewing on 
the response of the pile. The curves are selected in 
the same manner as the p-y curves, 

- to select curves of moment vs 
curvature or flexural rigidity (EI) vs moment for 
different axial-loading cases, 

v - to select the interaction diagram 
(ultimate moment vs axial load). To view the 
interaction diagram, at least three different axial 
loads must have been used in the computations. 

Generateal - to prepare the HD-LG-plot files and to 
select the pen speed, and 

Main - to return to the Main Menu. 

The pull-down menu shown below can be opened by pressing *'P@@ 

or moving the highlighted cursor to "Plot@@ followed by the <Enter> 
key. The following screen will be presented to illustrate the 

procedures to create a HP-GL-PLOT file to send to the pen plotter. 
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File View Plot Options 

.- 

Alt-X Exit 

Press Command Key: [RI . 

File View Plot options 

Selection of Responee Curves for Plotting 

Number Deflection Moment Shear Soil Reaction 

1 ON ON off off 

Toggle Plotting of Curves ON/off Using Space Bar- 

F8 : Continue 
Alt-X Exit 

Press Command Key: IF81. 
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File View Plot Options 

E&q 

Alt-X Exit 

Press Command Key: [Gl . 

File View Plot Options 

Preparing EiPGL plot file for p 
Enter file name for plotter fi 
Example. hpgw 

p-y Curves 
Response Curves 
Ultimate Moment 
Interaction Diagram 
Generate Plots 

e: 

Select Pen speed (l=slowt38.1 for high quality, 100 for max speed SOW 

A r1t-X Exit 
Press Command Key: [Enter]. 

85 

Arch
ive

d



File View Plot Options 

C624VIRW Version 2.0, Graphics Data: 
Number of p-y curves: NumPYcurve = 0 
Number of load-response curves: NumCurves = 0 
Number of point on load-response curves: Npts = 0 
Units are Pounds & Inches 
p-y Curves selected for viewing 

Response Curves selected for viewing 

212416 bytes available 
Largest block contains 212416 bytes 

The graphics data file is D:PLOTDATA 

Alt-X Exit 
Press Command Key: [ALTl [Xl l 
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After the HP-GL-plot files have been created, the user can 

exit (Alt-x) to DOS and use the following DOS commands to get hard 

copies from the HP-plotter. 

C:> MODE COM1:9600,N,7,1,P <CR> 
(For DOS 4.01 or higher, using the following 
MODE COM1:9600,N,7,1,B <CR>) 

C:> Print (HP-GL File-Name) <CR> 

Some parameters used in the Mode command may vary with the 

set-up of the hardware. The user should refer to the DOS Manual 

for proper changes. 

The Options selection of the Main Menu is used for several 

options relating to the display of data on the screen. The user 

can move the cursor to "Options" followed by the <Enter> key to 

open the first window as shown below. 

File View Plot options * 

Optional Plotting Control Values - Screen 1 of 2 

Symbol plotting increment .................... 
Upper y-value for p-y curves (in) ............ 
Limiting depth for response curve plots (in). 
Plotter X-coordinate for origin (in) ......... 
Plotter Y-coordinate for origin (in) ......... 
Plotter X-axis length (in) ................... 
Plotter Y-axis length (in) ................... 

2.00: 
600.000 

1.750 
1.500 
8.000 
5.000 

Symbol plotting increment is 0 for no symbols, 1 for every symbol, 2 for 
every 2nd point, 3 for every 3rd point, and so on. 

R 3:DEF:Num 6.0000000000E+02 

: Move Cell -3 : Help - F2 : Edit Cell - F8 : Continue - 
Alt-X Exit 

87 

Arch
ive

d



The first optional value is the increment used to mark individual 

data sets with unique symbols. Any value of increment may be 

used, including zero for no symbols at all. A legend defining the 

Symbols used by UPVIEW is displayed on each graph. 

The second optional value is the value of depth below which 

no response of the pile is displayed. The program will normally 

allow the user to view the curves showing the response of the pile 

over the full length of the pile. By setting the length to 

something less than the full length of the pile, the user may zoom 

in on the area where the response is most often critical. 

The third optional value is the y-value above which no p-y 

data are displayed. This allows the user to zoom in on the p-y 

values near the origin to examine the initial stiffness of the p-y 

curves. The other options are for the format used by the pen 

plotter. The most important option shown on the second window is 

the selection of a printing device. The printer may already be 

specified in the configuration file; however, the user may make a 

change here. The code for printers must be set before the 

command for "screen dump" can be sent. 

File View Plot Options 

Optional Plotting Control Values - Screen 2 of 2 

Axis Title Character Size (in) . . . . . . . . . . . . . . 0.15000 
Plotting Symbol Size (in) . . . . . . . . . . . . . . . . . . . 0.15000 
Plotter Pen Number for Axis Titles . . . . . . . . . . 1 
Plotter Pen Number for Axis and Borders . . . . . 
Plotter Pen Number for Data Line & Symbols . . : 
Type of Printer Used for Screen Dump . . . . . . . . 2 
Codes for printers: 1 = Epson MX, FX 

2 = Epson LQ 
3 = Toshiba 24-pin 
4 = HP LaserJet and DeskJet 
5 = HP InkJet 

= IBM Proprinter 
B = IBM Proprinter24. 

All printer output is sent to LPTl. 
TO redirect LPTl to COMl use the DOS MODE command. 

A 1:DEF:Num 1.5000000000E-01 

: Move Cell - ? : Help - F2 : Edit Cell - F8 : Continue - 
Alt-X Exit 
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CHAPTER 4. INPUT INFORMATION AND DATA STRUCTURE 

INTRODUCTION 

A user-friendly, menu-input, preprocessor C624EDIT was 

developed to create and edit input data for the computer program 
COM624P. C624EDIT is a full-screen editor and has an option t0 

save and retrieve data files. 

The user can also prepare an input file by following the 

line-by-line input guide with any available text editor. The 

structure of input data is presented in this chapter. It should 

be noted that all the data entry is free-field format with a 

maximum of 80 characters per line. Therefore, numerical data may 

be entered in fixed, floating-point, or exponential format as 

desired. A blank space is needed to separate two variables in the 
same line. The sequence of the line-by-line input format is 

presented in Appendix A. 

Data input is based on a coordinate system in which the pile 

head (top of pile) is the origin and the positive x-direction is 

downward (Fig. 4.1). The ground surface need not be at the 

elevation of the pile head. Sign conventions are shown in Fig. 

4.2. 

Any convenient and consistent units of force and length can 

be used. The program is set up to label the output in one of 

three ways. 

1. The user can designate that English units of inches and 

pounds will be used, and output will be labeled accordingly. 
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Origin-b 

X 

Pile Head 

-Y 

Ground Surface 

Tip of Pile 

Figure 4.1. Coordinate system. 
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Load 
Diogrom 

Shear 
Diagram 

Positive 
Load 

(0) 

Positive 
Shear 

(b) 

Moment 
Dio gram 

Poritive 
Moment 

(cl 

Slope 
Diagram Y 

X 

Positive 
Slope 

(d) 

Deflection 
Diagram 

r 
Y vt II 

X 

Positive 
Deflection 

(8) 

Figure 4.2. Sign conventions. 
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2. The user can specify that SI units of kilonewtons and 

meters will be used, and output will be labeled accordingly. 

3. The user can use any other consistent units (the 

computer does not need to know which ones) of force and length, 

and output will be labeled in terms of forces and lengths (F and 

L) l 

Several default values may be used in data input. Where the 

user desires to use a default value, the input should be left 

blank for the relevant variable. 

(In this section, the symbol 1tO1' denotes a capital letter 0; 

the symbol "0" denotes the number zero.) 

The following steps are recommended for preparation of input , 
of data. 

1. Decide which units will be used for force and length. 

2. Decide into how many increments the pile is to be 

divided. Up to 300 increments are allowed. Be sure to satisfy 

yourself that an adequate number of increments have been used to 

obtain a satisfactory solution. Some trials will be helpful as 

discussed in Part II on verification of results. 

3. Decide whether p-y curves will be input or whether they 

will be generated internally. If they are to be input, pick the 

depth for each curve, pick the number of points to be input for 

each depth, and tabulate the data. Up to 30 p-y curves are 

allowed. 
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4. If p-y curves are to be generated internally, divide the 

soil profile into from one to nine layers; decide which of the 

following p-y criteria will be used for each layer: 

l Matlock's (1970) criteria for soft clay; 

l Reese et al. 's (1975) criteria for stiff clay below 
the water table; 

l Welch and Reese's (1972) criteria for stiff clay above 
the water table; 

l Reese et al. 1s (1974) criteria for sand; and/or 

l Reese and Nyman's (1978) criteria for limestone. 

Estimate undrained shear strength c and strain at 50 percent 
stress level E50 for clay layers; estimate the angle of internal 

friction 4 for sand; and estimate the slope k of a plot of maximum 

soil modulus Es versus depth x for all strata. Be sure to read the 

background on any criteria that are used so that their basis and 

limitations are thoroughly understood. 

5. Select the length of the pile, the modulus of elasticity 

of the pile material, and the x-coordinate of the ground surface 

(x is equal to zero at the top of the pile). 

6. Divide the pile into from one to 10 segments with 

uniform cross-section. For each segment, tabulate the x- 

coordinate of the top of the segment, the diameter of the segment, 

the moment of inertia, and the pile cross-section area. 

7. If there are any distributed lateral loads on the pile, 

tabulate up to 10 points on a plot of distributed load versus 

depth below top of pile. 
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8. Tabulate up to 10 points on a plot of effective unit 

weight of soil versus depth. This step is not necessary if no p-y 

curves are generated internally. 

9. Tabulate up to 10 points on plots of c, Q, and &so versus 

X. Skip this step if no p-y curves will be generated internally. 

10. If p-y curves are generated internally in the program, 

tabulate any depths for which p-y curves are to be printed. 

Ordinarily, a few curves are printed for the purpose of 
verification. 

11. Determine the loads to be applied to the top of the 
pile: 

A. lateral load at pile head or lateral deflection at 
pile head; 

B. second boundary condition at pile head, which can 
be either, 

i. moment (&I, 

ii. slope (St), 

iii. rotational restraint (Mt/St); and 

C. axial load (assumed to be uniform over full length 
of pile). 

Up to 20 loading combinations can be input for each problem, 

e.g., to generate a load-deflection curve. 
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SELECTION OF BOUNDARY CONDITIONS AT PILE HEAD 

Four types of boundary conditions for the pile-head 

connection are implemented in Program COM624P. These are 

designated as Cases 1 through 4. The detailed information for 
modeling these boundary conditions is described in Chapter 2 of 

Part II of this manual. 

. Free to Rotatr DC=11 

The lateral load (Pt), the bending moment (Mt), and the axial 

load (Px) at the top of the pile are known. No rotational 

restraint will be provided by the superstructure, and the rotation 

at the top of the pile will depend only on the flexural rigidity 

of the pile itself. If the above conditions are met, the user can 

select this boundary condition for analysis. A typical example is 

a pile that is used to support an overhead sign. 

Frequently, the pile head is embedded into a monolithic 

reinforced-concrete cap. Conceptually, if the flexural rigidity 

of the pile cap is much stronger than that of a connected pile, 

the rotation angle between the pile head and the monolithic cap is 

unchanged with or without lateral bending. For such a case, the 
pile-head connection is defined as completely fixed and the 

rotation of the pile head within the monolithic concrete cap is 

assumed to be zero, in which case the slope (St) is set to zero. 

However, if a small rotation at the pile-head connection is 

allowed, the user can specify the slope (in radius) for the 

computation. To apply the boundary condition in Case 2, the 

lateral load (Pt), the slope or rotation (St) at the pile head, and 

the axial load (Px) should be given. 
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The connection between the pile and the superstructure, such 

as a steel frame, may not be always a perfectly rigid joint. If 

the magnitude of the restraint between the pile and superstructure 

can be estimated, and can be further expressed with a function of 
&/St (Mt and St are the bending moment and the slope angle at the 

pile head, respectively), the elastically-restrained boundary 

condition can be selected for use in Program COM624P. The elastic 
restraint Mt/St is largely affected by the stiffness of 

superstructures. The superstructures are different in many ways; 

therefore, the elastic restraint at each joint needs to be studied 

by using a sound structural theory. If there is a nonlinear 
relationship between Mt and St, iteration may be required to 

achieve compatibility. To apply this boundary condition, the 
lateral load (Pt), the elastic restraint (Mt/St), and the axial 

load (Px) , at the top of the pile must be known. 

If the pile-head deflection (yt), the bending moment (Mt), and 

the axial load (Px) at the top of the pile are given, then the user 

can use the boundary conditions in Case 4 for computation. The 

deflection of the pile head can be restrained in either direction. 

The reaction force at the pile head (restrained point) will be one 

of the outputs of the program. This boundary condition can be 

applied to piles which support a bridge abutment that has zero or 

a very small allowable movement. 

ITERATIONS OF COMPUTATIONS USING CRACXED/UNCRACICED EI 
GENERATED INTERNALLY BY SUBROUTINE PMEIX 

A new feature of the second version of Program COM624P is 

that the program will use a more rigorous approach to control the 
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use of cracked and untracked EI values during computation. The 

subroutine PMEIX will compute the ultimate bending moment for the 

selected section. For reinforced concrete sections, it will 

compute the EI values for untracked sections and for cracked 

sections. The user can manually input different EI values for 

several sections after examining the computer curve for bending 

moment and finding the length over which the moment distribution 

to the cracked-section conditions will exist. Two or three 

iterations may be required to achieve satisfactory results. 

Program COM624P provides an option for the user to request the 

computer to select values of EI internally for cracked or 

untracked sections for use in the iterations. 

Figure 4.3 shows the variation of bending moment and 

associated cracked/untracked EI values. As it may be seen, only 

the upper portion of the pile will be subjected to a large moment. 

Because the upper portion of the pile needs greater stiffness, the 

reinforcing steel can be enhanced only for that portion in order 

to reduce the pile deflection. 
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Figure 4.3. Bending moment and flexural rigidity 
versus depth for a laterally-loaded pile. 
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CHAPTER 5. EXAMPLE STUDIES 

INTRODUCTION 

This chapter presents six examples that were studied by use 

of COM624P. The first example is for a 14HP89 steel pile embedded 
in a single-layer deposit. The second example is for a 

reinforced-concrete pile embedded in a multi-layer deposit. The 

third example is for a pile embedded in a sloping abutment. The 

fourth example is to illustrate the use of p-y curves entered by 

the user. Examples 5 and 6 are included to illustrate the cases 

in which the ultimate bending moment and design of reinforcement 

are required. 

The examples that follow are intended to demonstrate the 

capability of the computer program and are not intended to be a 

complete presentation of the design process. The publication 

(FHWA-IP-84-11) entitled "Handbook on Design of Piles and Drilled 

Shafts under Lateral Load" is highly recommended for engineers 

seeking guidelines for design. There are a number of factors that 

must be considered in design before and after the computer 

execution. 

A general procedure on proper use of the program was 

developed by Christopher Dumas of FHWA during the design review 

and analysis of a case study for pile-supported abutment. The 

guidelines and procedures are presented in Appendix B. 

The program gives output as follows: 

Echo-print of input data, 

Generated p-y curves, 
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Listing of pile deflection, bending moment, shear, 
soil resistance, and flexural rigidity along 
the length of the pile, 

Summary results of pile-head deflection, maximum 
bending moment, and maximum shear force for 
various loading conditions, and 

Listing of bending moment, EI, neutral axis, and 
concrete strain at each curvature. 

From the variety of output that can be generated, the user should 

be able to get all the needed information on the response of a 

pile. 
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EXAMPLE 1, PILES IN A SINGLE LAYER OF SOIL 

A 14HP89 H-pile is used for the foundation of a bridge 

abutment. The width of the steel section is 14.7 in and the 

length of the pile is 25 feet. The soil deposit is a uniform 

stiff clay above the water table. The undrained cohesive strength 

is 14 lb/sq in, the total unit weight is 0.069 lb/cu in, and the 
E50 is 0.007. The value of soil modulus (k) is assumed for 

400/lb/cu inch. The user can estimate the value of k based on 

Table 3.2 in Part 11 of this manual if k-values were not measured 

for soils. The axial load is 39 kips and lateral loads at the 

pile head are 40 kips and 20 kips respectively. The pile head is 

assumed to be free to rotate. 

This example was used by the Design Handbook (FHWA-IP-84-11) 

in Section 3.5, Page 75. In regard to the aspects of design, 

thorough discussions have been given in the handbook. The users 

are encouraged to read that section. The strong axis of the pile 

(Ix - 904 in4) will be used to resist the lateral load. 

Therefore, the width (14.7 in) of the flange was used as the 

equivalent diameter for the input required by Program COM624P. 

The input file created by C624EDIT is presented on the next 

page followed by a listing of the output data. The computed 

maximum bending moment on the pile is less than the yield moment 

(5.84 x lo3 in-kip) of the section. In this example the user can 

increase the lateral load until the ultimate bending moment is 
* reached. The service load can be selected by dividing the maximum 

lateral load, which creates the ultimate bending moment, with a 

load factor. The load factor can be 2 to 2.5 depending on the 

importance of the structure. The deflection under the service 

load also needs to be satisfied by the design specifications. The 

graphics display of p-y curves, pile-deflection curves, and 

bending moment curves are also presented for verification. 
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The input and output data are shown in the following pages. 
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File- Analysis Mult Option 

C624EDIT 2.0, Edit Variables: 

This program is a preprocessor developed especially for users 
for preparation of input for the computer program COM624P. The 
main menu for this program is displayed as a bar at the top 
row of the screen. The main menu has four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The selection of the ANALYSIS menu allows the 
user to enter required data for computing the response of the pile 
and soil, such as distributions of deflection, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile size for computing the ultimate bending moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
for most computer systems. 

Fl-Help Alt-X-Exit 

File Analysis Mult Option 

Read Read 
New New 
Save Save u u Directory Directory 
Change dir Change dir 
Quit to DOS Quit to DOS 
Main Menu Main Menu 

I 
Fl-Help Fl-Help Alt-X-Exit Alt-X-Exit 
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File Analysis Mult 

New File Name 
EXAMPLE.INl 

Option EXAMPLE. IN1 

1 

Fl-Help Alt-X-Exit 

File Analysis+ Mult Option 

C624EDIT 2.0, Edit Variables: 

This Program is a preprocessor developed especially for users 
for Preparation of input for the computer program COM624P. The 
main menu for this program is displayed as a bar at the top 
row of the screen. The main menu has four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The selection of the ANALYSIS menu allows the 
user to enter required data for computing the response of the pile 
and soil, such as distributions of deflection, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile size for computing the ultimate bending moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
for most computer systems. 

Fl-Help Alt-X-Exit 
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File Analysis Mult 

Title- 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

Fl-Help Alt-X-Exit 

Option 

File Analysis Mult Option EXAMPLE.INl 

1 4 l:DEF:Lab EXAMPLE 1 PILES IN A SINGLE LAYER OF SOIL 

Enter title for this data file (up to 72 characters long) 

EXAMPLE 1 PILES IN A SINGLE LAYER OF SOIL 

: Move Cell - ? : Help - / : Edit Screen F8 : Continue - 
Fl-Help Alt-X-Exit 
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File Analysis Mult 

Title 
Pile Properties+ 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
output Tables 
Main Menu 

Option 

Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE. IN1 

Editing Pile Dimensions 

Number of increments (c= 3001 . . . . . . . . . . . . . . . . . . . . . 
Distance from top of pile to ground surface - inches 
Length of pile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Pile modulus 

inches 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Psi 

Slope of ground surface (degrees) . . . . . . . . . . . . . . . . . 

120 

300% 
29000000 

0.0000 

i 1:DEF:Num 120 

- : Move Cell - 
Fl-Help Alt-x-Exit? 

: Help - / : Edit Screen- FE : Continue + 
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File Analysis Mult Option EXAMPLE. IN1 

Editing Pile Section Properties 

Section TOP Depth Diameter Mom. of Inert. Area 
# inches inches inches**4 inches= 
t 0.00 14.700 904.0000 26.1000 

3 
4 

2 
7 
8 
9 

10 

To access pile property library leave pile diameter blank. 

I A 1:DEF:Num 0.00000 

: Move Cell - 7 : Help - / : Edit Screen----- FS : Continue - 
Fl-Help Alt-X-Exit 

File Analysis Mult Option 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu t 

Fl-Help Alt-X-Exit 
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File Analysis Mult Option EXAMPLE.INl 

I 
Editing Soil Layer Information 

Layer Criteria x-top X-bot k 

! ! 
inches inches lb/in3 

0.00 360.00 400.00 
2 
3 
4 

6" 
7 
8 
9 

10 
p-y Curve Criteria 

#1 = Soft Clay Criteria 

:: 
= Stiff Clay Below Watertable :: 

= stiff Clay Above Watertable 
= Sand 

= Interp. Between Input Curves #6 = Vuggy Limestone 

A 1:DEF:Num 3 

1 : Move Cell - 3 : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE. IN1 

Editing Effective Unit Weight Information 

Point 

: 
2 

: 

2 
7 

: 
10 

Depth Unit Weight 

inches 0.00 lb/in3 0.069 
360.00 0.069 

A 1:DEF:Nurn 0.00000 

: Move Cell - : Help - / : Edit Screcv F8 : Continue - 
Fl-Help Alt-X-Exit? 
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File Analysis Mult Option EXAMPLE.INl 

I Editing Shear Strength Information 
I 

Layer Depth ES0 
# inches PST de:. e sob 0f c 

1 0.00 14.000 0.00 0.0070 
i 360.00 14.000 0.00 0.0070 

4 

z 

l! 

lo’ 

A 1:DEF:Num 0.00000 

: Move Cell - 3 : Help - / : Edit Screen---- F8 : Continue 1 
Fl-Help Alt-X-Exit 

File Analysis Mult 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading4 
Computation Control 
Output Tables 
Main Menu 

Option 

Fl-Help Alt-X-Exit 
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File Analysis Mult Option EXAMPLE.INl 

Editing Loading Information 

Distributed lateral loading (y/n) ? ............... n 
Is loading cyclic (y/n) 7 ......................... n 
Boundary condition code (KBC) ..................... 1 

KBC = 1 for shear and moment 
KBC = 2 for shear and slope 
KBC = 3 for shear and rotational restraint 
KBC = 4 for deflection and moment 

A 1:DEF:Lab n L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE.INl 

Editing Pile-head Loading 

KOP 

1 
1 

Shear Moment Axial Load 
pounds in-lbs pounds 

20000.00 0.000 39000.00 
40000.00 0.000 39000.00 

I KOP=O if only a summary output for this load is to be printed 
=l if complete output is desired for this load 

A 1:DEF:Nm 1 L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 
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File Analysis Mult 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control-4 
Output Tables 
Main Menu 

Option 

Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE.INl 

Maximum number of iterations allowed for analysis : 100 
Tolerance on solution convergence, inches : 0.000010 
Value of deflection considered to be excessive, inches 
Computation using internal-generated cracked/untracked EIi N 

147.0000 

4 l:DEF:Num 100 

- : Move Cell - ? : Help - / : Edit Screen- F8 : Continue /' 
Fl-Help Alt-X-Exit 
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File Analysis Mult Option 

~Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables4 
Main Menu 

& 

Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE.INl 

Output Printing Options 

*** Lateral Load Analysis l ** 

Printing Increment (1 for every node, 2 for every other node, etc) 2 
Print deflection, moment, shear over full length of pile (y/n) 
Print p-y curves for verification :: 

4 1:DEF:Num 2 

- : Move Cell - 7 : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 
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File Analysis Mult Option EXAMPLE.INl 

Enter depths for which p-y curves are to be calculated for verification: 

Point 

i 

: 
5 

; 

i 
10 

Depth inches 

20.00 
60.00 

100.00 
150.00 

A 1:DEF:Num 20.00000 

F8 : Continue - 
Fl-Help 

: Move Cell - ? : Help - / : Edit Screen- 
Alt-X-Exit 

File Analysis Mult 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu- 

Fl-Help Alt-X-Exit 

Option 
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File Analysis Mult Option EXAMPLE.INl 

Save - 

I  

t  

Fl-Help Alt-X-Exit 

1 

File Analysis Mult 

Read 
New 1 Save 

Save File Name 
EXAMPLE.INl 

Option EXAMPLE.INl 

?l-Help Alt-X-Exit 
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EXAMPLE 1 PILES IN A SINGLE LAYER OF SOIL 

UNITS--ENGL 

**************************************************u********** 

PILE DEFLECTION, BENDING MOMENT, SHEAR & SOIL RESISTANCE 
************************************************************* 

INPUT INFORMATION 
********************************* 

TBE LOADING IS STATIC 

PILE GEOMETRY AND PROPERTIES 

PILE LENGTH = 
MODULUS OF ELASTICITY OF PILE = 

1 SECTION(S) 

X DIAMETER 

IN IN 
.oo 

14.700 
300.00 

SOILS INFORMATION 

X-COORDINATE AT THE GROUND SURFACE 

SLOPE ANGLE AT THE GROUND SURFACE 

1 LAYER(S) OF SOIL 

LAYER 1 

= 

I 

.OO IN 

.OO DEG. 

THE LAYER IS A STIFF CLAY ABOVE THE WATER TABLE 
X AT TNE TOP OF THE LAYER s .OO IN 
XATTHEBOTTOMOFTHELAYER = 360.00 IN 
VARIATION OF SOIL MODULUS, k = .400E+03 LBS/IN**3 

300.00 IN 
.2903+05 KIP/IN**2 

MOMENT OF 
INERTIA 

IN**4 IN**2 

.9043+03 .261E+02 
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DISTRIBUTION OF EFFECTIVE UNIT WEIGHT WITH DEPTH 
2 POINTS 

X,IN WEIGHT,LBS/IN**3 
.oo .69E-01 

360.00 .69E-01 

DISTRIBUTION OF STRENGTH PARAMETERS WITH DEPTH 
2 POINTS 

X,IN C,LBS/IN**2 PHI,DEGREES ES0 
.oo .140E+02 ,000 .700E-02 

360.00 .140E+02 .ooo .700E-02 

FINITE DIFFERENCE PARAMETERS 
NUMBER OF PILE INCREMENTS = 120 
TOLERANCE ON DETERMINATION OF DEFLECTIONS = .lOOE-04 IN 
MAXIMUM NUMBER OF ITERATIONS ALLOWED FOR PILE ANALYSIS = 100 
MAXIMUM ALLOWABLE DEFLECTION = .15E+03 IN 

INPUT CODES 
OUTPT = 1 
KCYCL = 1 
KBC =l 
KPYOP = 1 
INC = 2 

EXAMPLE 1 PILES IN A SINGLE LAYER OF SOIL 

UNITS--ENGL 

OUTPUT INFORMATION 
*********************************** 

GENERATED P-Y CURVES 

THENUMBEROF CURVE IS 

THE NUMBEROF POINTS ON EACH CURVE 

= 4 

= 17 
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DEPTH BELOW GS DIAM 

2200 1r700 
LB&**2 LB;E**2 LB:%*3 

E50 

.lE+02 .lE+02 .7E-01 .700E-02 
Y 

X0 
LB& 

.ooo 
.274 395.168 
.549 469.936 
.823 520.070 

1.098 558.852 
1.372 590.914 
1.646 618.471 
1.921 642.771 
2.195 664.590 
2.470 684.451 
2.744 702.719 
3.018 719.664 
3.293 735.490 
3.567 750.356 
3.842 764.387 
4.116 777.686 
5.145 777.686 

DEPTH BELOW OS DIAM 

6i:OO 1::700 
LB&*'2 LB:%**2 LB:=*3 

E50 

.lE+02 .lE+OZ .7E-01 .700E-02 
Y 

.ZO 
LB&N 

.ooo 
.274 558.061 
.549 663.650 
.823 734.449 

1.098 789.217 
1.372 834.496 
1.646 873.412 
1.921 907.729 
2.195 938.543 
2.470 966.590 
2.744 992.388 
3.018 1016.318 
3.293 1038.668 
3.567 1059.662 
3.842 1079.477 
4.116 1098.258 
5.145 1098.258 
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DEPTH BELOW GS DIAM ES0 

lo~:oo 1~~700 .lE+O2 .lE+02 .7E-01 .lOOE-02 

Y P 

.%O 
LBS/IN 

.ooo 
.274 720.954 
.549 857.364 
.823 948.829 

1.098 1019.583 
1.372 1078.078 
1.646 1128.354 
1.921 1172.687 
2.195 1212.495 
2.470 1248.729 
2.744 1282.058 
3.018 1312.973 
3.293 1341.847 
3.567 1368.968 
3.842 1394.568 
4.116 1418.830 
5.145 1418.830 

DEPTH BELOW GS DIAM E50 

15~:oo 1::700 
LBS,:N**2 LB:%**2 LB:%*3 

.lE+OZ .lE+02 .7E-01 .700E-02 
Y 

.ZO 
.274 
.549 
.823 

1.098 
1.372 
1.646 
1.921 
2.195 
2.470 
2.744 
3.018 
3.293 
3.567 
3.842 
4.116 
5.145 

LB&N 
,000 

924.570 
1099.506 
1216.803 
1307.540 
1382.555 
1447.031 
1503.885 
1554.936 
1601.403 
1644.145 
1683.791 
1720.819 
1755.601 
1788.430 
1819.545 
1819.545 

---------- *** -----e---- 
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PILE LOADING CONDITION 

LATERAL LOAD AT PILE HEAD 
APPLIED MOMENT AT PILE HEAD 
AXIAL LOAD AT PILE HEAD 

= .200E+02 KIP 
= .OOOE+OO IN-KIP 
= .3903+02 KIP 

.oo .145E+OO 
5.00 .134E+OO 

10.00 .123E+OO 
15.00 .112E+OO 
20.00 .lOlE+OO 
25.00 .910E-01 
30.00 .812E-01 
35.00 .718E-01 
40.00 .6293-01 
45.00 .546E-01 
50.00 .4683-01 
55.00 .396E-01 
60.00 .331E-01 
65.00 .2723-01 
70.00 .2193-01 
75.00' .172E-01 
80.00 .132E-01 
85.00 .972E-02 
90.00 .6823-02 
95.00 .4443-02 

100.00 .2553-02 
105.00 .llOE-02 
110.00 .3673-04 
115.00 -.700E-03 
120.00 -.117E-02 
125.00 -.141E-02 
130.00 -.150E-02 
135.00 -.1453-02 
140.00 -.132E-02 
145.00 -.114E-02 
150.00 -.938E-03 
155.00 -.7293-03 
160.00 -.5333-03 
165.00 -.3633-03 
170.00 -.2253-03 
175.00 -.121E-03 
180.00 -.511E-04 
185.00 -.9933-05 

X DEFLECTION MOMENT TOTAL SHEAR SOIL FLEXURAL 
STRESS RESIST RIGIDITY 

IN IN IN-SUP LBS/IN**2 KIP LBS/IN KIP-IN**2 
***** ********** ********** ********** ********** ********** ********** 

.2623+08 

.2623+08 

.262E+08 

.262E+08 
.2623+08 
.2623+08 
.262E+08 
.262E+08 
.2623+08 
.2623+08 
.2623+08 
.2623+08 
.262E+08 
.2623+08 
.262E+08 
.2623+08 
.262E+08 
.2623+08 
.262E+08 
.2623+08 
.2623+08 
.2623+08 
.262E+08 
.2623+08 
.262E+08 
.262E+08 
.2623+08 
.2623+08 
.2623+08 
.262E+08 
.2623+08 
.2623+08 
.262E+08 
.2623+08 
.262E+08 
.262E+08 
.2623+08 
.2623+08 

.OOOE+OO 

.9713+02 

.1873+03 

.2703+03 

.3453+03 

.413Iz+03 

.4733+03 

.524E+03 

.5683+03 

.6033+03 

.630E+03 

.6493+03 

.6593+03 

.6613+03 

.6553+03 
.6413+03 
.6193+03 
.5893+03 
.553E+03 
.5093+03 
.4603+03 
.4053+03 
.3453+03 
.2843+03 
.227E+03 
.1763+03 
.130E+03 
.8923+02 
.546E+02 
.2593+02 
.287E+Ol 

-.1463+02 
-.2673+02 
-.3393+02 
-.3663+02 
-.3533+02 
-.3063+02 
-.232E+02 

.1493+04 

.2283+04 

.3023+04 

.369E+04 

.4303+04 

.4853+04 

.5343+04 

.576E+04 

.611E+04 

.6403+04 

.6623+04 

.6773+04 

.6853+04 
.687E+04 
.682E+04 
.6703+04 
.6523+04 
.6293+04 
.5993+04 
.564E+04 
.523E+04 
.4793+04 
.4303+04 
.3803+04 
.3343+04 
.2923+04 
.2553+04 
.2223+04 
.194E+04 
.170E+04 
.152E+04 
.161E+04 
.171E+04 
.1773+04 
.1793+04 
.178E+04 
.174E+04 
.1683+04 

.201E+02 

.1863+02 

.1723+02 

.1573+02 

.1423+02 

.1273+02 

.lllE+02 

.9453+01 

.781E+Ol 

.615E+Ol 

.4493+01 

.283E+Ol 
.118E+ol 

-.4563+00 
-.206E+Ol 
-.3643+03 
-.516E+Ol 
-.663E+Ol 
-.802E+Ol 
-.9323+01 
-.105E+02 
-.115E+02 
-.1233+02 
-.118E+02 
-.108E+02 
-.9783+01 
-.8653+01 
-.750E+Ol 
-.633E+Ol 
-.517E+Ol 
-.404E+Ol 
-.2953+01 
-.192E+Ol 
-.9743+00 
-.127E+OO 

.613E+OO 

.123E+Ol 

.170E+Ol 

.2673+03 

.2793+03 

.2903+03 

.2993+03 

.308E+O3 

.3153+03 

.3213+03 

.3263+03 

.3303+03 

.3323+03 

.3323+03 

.332E+03 

.329E+03 

.3253+03 

.3183+03 
.310E+03 
.2993+03 
.286E+03 
.270E+03 
.250E+03 
.224E+03 
.1873+03 
.805E+02 

-.1763+03 
-.2053+03 
-.2211+03 
-. 2293+03 
-.2331+03 
-.233E+03 
-.2303+03 
-.224E+03 
-.2143+03 
-.1983+03 
-.180E+03 
-.1593+03 
-.1363+03 
-.llOE+03 
-.7293+02 
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190.00 .9253-05 
195.00 .145E-04 
200.00 .1243-04 
205.00 .7723-05 
210.00 .343E-05 
215.00 .840E-06 
220.00 -.529E-07 
225.00 -.9813-07 
230.00 -.127E-07 
235.00 .6023-09 
240.00 -.181E-13 
245.00 .2893-18 
250.00 -.4603-23 
255.00 .732E-28 
260.00 -.1163-32 
265.00 .1853-37 
270.00 -.2933-42 
275.00 .4643-47 
280.00 -.7333-52 
285.00 .1163-56 
290.00 -.183E-61 
295.00 .2883-66 
300.00 -.924E-71 

-.145E+02 
-.7553+01 
-.257E+Ol 

.4993+00 

.186&+01 

.184E+Ol 

.857E+OO 

.lOlE+OO 
-.967E-01 
-.502E-02 

.2743-04 
-.4523-09 

.7463-14 
-.1233-18 

.2033-23 
-.3343-28 

.5503-33 
-.9053-38 

.1493-42 
-.245E-47 

.4033-52 
-.6633-57 

.OOOE+OO 

.161E+04 

.1563+04 

.152E+04 

.150E+04 

.151E+04 

.151E+04 

.150E+04 

.150E+04 

.150E+04 

.1493+04 

.1493+04 

.1493+04 

.1493+04 

.1493+04 

.149E+O4 

.149E+O4 

.1493+04 
.149E*O4 
.149E+04 
.1491+04 
.149E+O4 
.1493+04 
.149E+O4 

.158E+Ol 

.120E+Ol 

.aolE+oo 

.4373+00 

.125E+OO 
-.113E+OO 
-.207E+OO 
-.921E-01 

.1363-02 

.107E-01 
-. 4943-03 

.lSOE-07 
-.2393-12 

.3813-17 
-.6063-22 
-.1333-28 

.219E-33 
-.361E-38 

.5933-43 
-.976E-48 

.1613-52 
-.2643-57 

. OOOE+OO 

.718E+O2 

.8033+02 

.7723+02 

.6863+02 

.5603+02 

.3943+02 
-.1963+02 
-.2303+02 
-.1393+02 

.6543+01 
-.512E+OO 

.1573-04 
-. 2503-09 

.3963-14 
-.6293-19 

.9963-24 
-.1573-28 

.249E-33 
-. 3933-38 

.6183-43 
-.9733-48 

.1533-52 
-.489E-57 

.2623+08 

.262E+08 

.2623+08 

.2623+08 

.262E+08 

.262E+08 

.262E+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.262E+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

COMPUTED LATERAL FORCE AT PILE HEAD 
COMPUTED MOMENT AT PILE HEAD 
COMPUTED SLOPE AT PILE HEAD 

TBE OVERALL MOMENT IMmLANCE 
THE OVERALL LATERAL FORCE IMBALANCE 

= .20000E+02 KIP 
= .OOOOOE+OO IN-KIP 
= -.221783-02 

= .103E-09 IN-UP 
= .6123-08 LBS 

OUTPUT SUMMARY 

PILE HEAD DEFLECTION = .145E+OO IN 
MAXIMUM BENDING MOMENT = .6613+03 IN-UP 
MAXIMUMTOTAL STRESS = .6873+04 LBS/IN**2 

NO. OF ITERATIONS = 
MAXIMUM DEFLECTION ERROR = .949E-:i IN 

--------e- *** ---a------ 

PILE LOADING CONDITION 
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LATERAL LOAD AT PILE HEAD 
APPLIED MOMENT AT PILE HEAD 
AXIAL LOAD AT PILE HEAD 

= .400E+02 KIP 
= .OOOE+OO IN-KIP 
= .390E+02 KIP 

X DEFLECTION MOMENT TOTAL SHEAR SOIL FLEXURAL 
STRESS RESIST RIGIDITY 

IN IN IN-RIP LBS/IN**2 KIP LBS/IN KIP-IN**2 
***** ********** ********** *It******** *******t** ********** ********** 

.oo .6233+00 
5.00 .5863+00 

10.00 .5493+00 
15.00 .512E+OO 
20.00 .4763+00 
25.00 .441E+OO 
30.00 .406E+OO 
35.00 .372E+OO 
40.00 .340E+OO 
45.00 .308E+OO 
50.00 .2783+00 
55.00 .250E+OO 
60.00 .2233+00 
65.00 .197E+OO 
70.00 .173E+OO 
75.00 .lSOE+OO 
80.00 .130E+OO 
85.00 .lllE+OO 
90.00 .931E-01 
95.00 .7723-01 

100.00 .630E-01 
105.00 .504E-01 
110.00 -3923-01 
115.00 .2963-01 
120'.00 .213E-01 
125.00 .144E-01 
130.00 .8673-02 
135.00 .4053-02 
140.00 .432E-03 
145.00 -.230E-02 
150.00 -.4283-02 
155.00 -.5603-02 
160.00 -.6393-02 
165.00 -.6743-02 
170.00 -.6733-02 
175.00 -.6463-02 
180.00 -.5993-02 
185.00 -.5383-02 
190.00 -.4703-02 

.ooOE+OO .1493+04 .4033+02 .3a53+03 .262E+08 

.197E+03 .3093+04 .3803+02 .4043+03 .2623+08 

.3833+03 .4613+04 .360E+02 .4223+03 .245213+oa 

.5593+03 .6043+04 .3383+02 .4383+03 .2623+08 
.7243+03 .7383+04 .316E+02 .454E+03 .2623+08 
.8783+03 .8633+04 .293E+02 .468E+O3 .2623+08 
.102E+04 .9783+04 .2693+02 .481E+O3 .262E+08 
.115E+04 .108E+05 .2453+02 4923+03 
.1273+04 .118E+05 .2203+02 :503E+03 

.262E+08 

.262E+08 
.1373+04 .126E+05 .1953+02 .512E+03 .2623+08 
.146E+04 .1343+05 .1693+02 .519E+03 .2623+08 
.154E+04 .140E+05 .1433+02 .5253+03 .262E+08 
.161E+04 .1463+05 .116E+02 .530E+O3 .262E+08 
.166E+04 .lSOE+OS .8973+01 .532E+03 .262E+08 
.170E+04 .1533+05 .630E+Ol .5333+03 .262E+08 
.1733+04 .1553+05 .3643+01 .5333+03 .2623+08 
.1743+04 .1563+05 .9783+00 .5303+03 .2623+08 
.1743+04 .156E+05 -.166E+ol .5263+03 .2623+08 
.1723+04 .1553+05 -.4283+01 .5193+03 .2623+08 
.170E+04 .1533+05 -.6853+01 .510E+03 .2623+08 
.1663+04 .lSOE+OS -.9373+01 .4993+03 .262E+OB 
.160E+04 .1453+05 -.118E+02 .4853+03 .2623+08 
.1543+04 .140E+05 -.1423+02 .468E+03 .2623+08 
.1463+04 .1343+05 -.1653+02 .44aE+03 .2623+08 
.1373+04 .1273+05 -.1873+02 .4243+03 .2623+08 
.128E+04 .119E+05 -.2073+02 .3943+03 .2623+08 
.117E+O4 .llOE+OS -.2263+02 .355E+03 .262E+O8 
.105E+04 .lOOE+OS -.2433+02 .301E+03 .2623+08 
.9253+03 .9023+04 -.2553+02 .176E+O3 .262E+08 
.798E+03 .798E+O4 -.2483+02 -.2743+03 .262E+08 
.6783+03 .700E+04 -.2333+02 -.3273+03 .262E+08 
.5653+03 .6093*04 -.2163+02 -.3563+03 .2623+08 
.4623+03 .525E+O4 -.1983+02 -.3683+03 .2623+08 
.367E+03 .448E+04 -.180E+02 -.3733+03 .2623+08 
.2a23+03 .3793+04 -.161E+02 -.3733+03 .2636+&2 
.2063+03 .317E+04 -.1423+02 -.3693+03 .262E+OS 
.140E+03 .263E+04 -.1243+02 -.3623+03 .2623+08 
.8223+02 .2163+04 -.106E+02 -.3523+03 .2623+08 
.3343+02 .1773+04 -.889E+oi -.3403+03 .2623+08 
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195.00 -.398E-02 
200.00 -.327E-02 
205.00 -.2603-02 
210.00 -. 198E-02 
215.00 -.145E-02 
220.00 - .994E-03 
225.00 -.6313-03 
230.00 -.3563-03 
235.00 -.162E-03 
240.00 -.3793-04 
245.00 .311E-04 
250.00 .6063-04 
255.00 .6463-04 
260.00 .5433-04 
265.00 .3843-04 
270.00 .2263-04 
275.00 .104E-04 
280.00 .310E-05 
285.00 .1283-06 
290.00 -.2453-06 
295.00 -.153E-08 
300.00 .5383-13 

-.6823+01 
-.3893+02 
-.6323+02 
-.802E+02 
-. 9043+02 
-. 942E+02 
-.9223+02 
-.850E+02 
-.7353+02 
-.5823+02 
-.4133+02 
-.2663+02 
-.1473+02 
-.580E+Ol 

.332E+OO 

.390E+Ol 

.521E+Ol 
.466E+Ol 
.2753+01 
.580E+OO 

-.4463+00 
.OOOE+OO 

.1553+04 

.181E+04 

.201E+04 

.2153+04 

.2233+04 

.2263+04 

.2243+04 

.2193+04 

.2093+04 

.1973+04 

.1833+04 

.171E+04 

.161E+04 

.1543+04 

.150E+04 

.153E+04 

.1543+04 

.1533+04 
.152E+04 
.150E+04 
.150E+04 
.1493+04 

-.722E+Ol 
-.563E+Ol 
-.412E+Ol 
-.2693+01 
-.137E+Ol 
-.163E+OO 

.930E+OO 

.189E+Ol 

.271E+Ol 

.3343+01 

.32OE+Ol 

.2663+01 

.207E+Ol 
.150E+Ol 
.962E+OO 
.4793+00 
.6573-01 

-.260E+OO 
-. 459E+OO 
-.3323+00 

.219E-01 

.OOOE+OO 

-.327E+03 
-.311E+03 
-. 2943+03 
-.274E+03 
-.2543+03 
-.2313+03 
-.2063+03 
-.1793+03 
-.1473+03 
-.102E+03 

.9693+02 

.115E+03 

.116E+O3 

.lllE+03 

.102E+O3 

.8953+02 

.7373+02 
.5443+02 
.2663+02 

-.254E+02 
.3293+01 

-.517E-01 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.2623+08 

.262E+08 

.2623+08 

.262E+08 

.2623+08 
.2623+08 
.262E+08 
.2623+08 
.2623+08 

COMPUTED LATERAL FORCE AT PILE HEAD 
COMPUTED MOMENT AT PILE READ 
COMPUTED SLOPE AT PILE BEAD 

THE OVERALL MOMENT IMBALANCE 
TRE OVERALL LATERAL FORCE IMBALANCE 

= .40000E+02 KIP 
=: .OOOOOE+OO IN-ICIP 
= -.745023-02 

= -.2783-07 IN-KIP 
= .5633-06 LBS 

OUTPUT StlmARY 

PILE READ DEFLECTION = .6233+00 IN 
MAXIMUM BENDING MOMENT = .1743+04 IN-KIP 
MAXIMUMTOTALSTRESS = .1563+05 LBS/IN**2 

NO. OF ITERATIONS I 27 
MAXIMUM DEFLECTION ERROR = .8803-05 IN 

SUMMARY TABLE 
************************* 

LATERAL BOUNDARY AXIAL MAX. MAX. 
LOAD CONDITION LOAD MOMENT STRESS 

(KIP) BC2 (KIP) ( I::IN ) (IN-KIPI (LBS/IN**2 
.200E+02 . OOOE+OO .3903+02 .145E+OO 
.400E+02 . OOOE+OO 

-.2223-02 
.3903+02 

.661E+O3 
.6233+00 

.6873+04 
-.7453-02 .1743+04 .1563+05 
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EXAMPLE 2, CONCRETE PILES IN LAYERED SOIL WITH 
DISTRIBUTED LOAD 

This example is included to illustrate a common case in which 

a 36-in diameter, reinforced-concrete pile is subjected to both 

horizontal and vertical forces at the top of the pile. 

Distributed loads are also specified near the top portion of the 

pile. The soil deposit is not uniform and, as shown in Fig. 5.1, 

five different layers are encountered in this example. 

The recommendations for p-y curves for layered soils are 

presented in Chapter 3 of Part II of this manual. The computer 

will calculate the equivalent thickness for each layer. If the 

user wants to check the p-y curves generated by the computer, the 

equivalent thickness should be taken into account. The p-y curves 

for rock at the fifth layer were generated internally by the 

computer. The only parameter that is needed for rock is the shear 
strength. The modulus k and &SO are only used for the initial 

condition. It should be noted that the shear strength is half of 

the uniaxial compression strength reported for most rock 

specimens. 

Layered-soil is commonly encountered in routine design. It 

should be noted that there may be some uncertainty regarding the 

theory used for conversion of layered soils. If soil layers do 

not change their natural properties dramatically (for example, 

sandy layers with differing angles of friction) then the best 

approach for modeling the soil response is to use a lower number 

of layers. However, care must be taken to characterize in detail 

the strength variation profile in the input data. 

The input and output data are shown in the following pages. 
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kips 

20 in.1 - 

Stiff Clay 

Sand 

Soft Clay 

Stiff Clay 

Limestone 

Pile Length - 500 in. 
Pile Diameter - 36 in. 

in-kip 

c = 2000 lb/sq ft. 
y- 125 lb/cu ft. 

E - 0.005 
50 

$- 30 deg 

f- 60 lb/cu ft. 

c - 800 lb/sq ft. 
f- 60 lb/cu ft. 

e - 0.02 
50 

-- 

c * 3000 lb/sq ft. 

Y,'I 60 lb/cu ft. 

& - 0.005 
50 

?/- 60 lb/cu ft. 

c = 408,816 lbhq ft. 

6 
Modulus of Elasticity - 3.1 X 10 lb/sq in. 

60 in. 

120 in. 

60 in. 

144 in. 

Figure 5.1. Data for Example 2. 
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File+ Analysis Mult 

C624EDIT 2.0, Edit variables: 

Option 

This program is a preprocessor developed especially for users 
for preparation of input for the computer program COM624P. The 
main menu for this program is displayed as a bar at the top 
row of the screen. The main menu has four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The selection of the ANALYSIS menu allows the 
user to enter required data for computing the response of the pile 
and soil, such as distributions of deflection, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile size for computing the ultimate bending moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
for most computer systems. 

I I 
Fl-Help Alt-X-Exit 

File Analysis Mult Option 

New - 

Fl-Help Alt-X-Exit 
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File Analysis Mult Option 

ii?---] 
New File Name 

RXAMPLE.IN2 
I 

Change dir 
Quit to DOS 
Main Menu I 

Fl-Help Alt-X-Exit 

File Analysis Mult Option 

L 
Fl-Help Alt-X-Exit 
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File Analysis+ Mult Option 

C624EDIT 2.0, Edit Variables: 

This program is a preprocessor developed especially for users 
for preparation of input for the computer program COM624P. The 
main menu for this program is displayed as a bar at the top 
row of the screen. The main menu has four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The selection of the ANALYSIS menu allows the 
user to enter required data for computing the response of the pile 
and soil, such as distributions of deflection, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile size for computing the ultimate bending moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
for most computer systems. 

Fl-Help Alt-X-Exit 

File Analysis Mult 

I 

option 

Title - 
Pile Properties 

soil Properties 
Lateral p-y Data 
Data for Loading 

lComputation Control 
IOutput Tables 
Main Menu 

'l-Help Alt-X-Exit 
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File Analysis Mult Option EXAMPLE.IN2 

Enter title for this data file (up to 72 characters long) 

EXAMPLE 2 CONCRETE PILES IN LAYEBED SOIL WITH DISTRIBUTED LOADS 

I A 1:DEF:Lab EXAMPLE 2 CONCRETE PILES IN LAYERED SOIL WITH DISTRIBUTED LOADS 

: Move Cell - 7 : Help - 
Fl-Help 

/ : Edit Screen--- 18 
Alt-X-Exit 

: Continue - 

File Analysis Mult 

Title 
Pile Properties4 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

Option 

Fl-Help Alt-X-Exit 
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File Analysis Mult option EXAMPLE.IN2 

Editing Pile Dimensions 

Number of increments (<= 300) ..................... 
Distance from top of pile to ground surface - inches 
Length of pile .............................. inches 
Pile modulus ................................ 
slope of ground surface (degrees) 

Psi 
................. 

100 
20.0 

500.00 
3100000 

0.0000 

A 1:DEF:Num 100 

- : Move Cell - 7 : Help - / : Edit Screen- F8 : Continue I J 
Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE.IN2 

Editing Pile Section Properties 

Section Top Depth Diameter Mom. of Inert. Area 

r 
inches inches inches**4 inches2 

0.00 36.000 82500.0000 1080.0000 
2 300.00 36.000 61500.0000 1080.0000 

: 
5 
6 
7 
8 
9 

10 

To access pile property library leave pile diameter blank. 

A 1:DEF:Num 0.00000 L : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 
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File Analysis Mult Option 

Title 
Pile Properties4 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

Fl-Help Alt-X-Exit 

File Analysis Mult Option BXAMPLE.IN2 

Editing Soil Layer Information 

Layer Criteria x-top X-bot 
: 1 inches 20.00 inches 80.00 1000.00 lbFin3 

2 : 80.00 200.00 60.00 
: 

ii 

260.00 200.00 404.00 260.00 1200.00 200.00 

2 404.00 600.00 2000.00 

7 

i 
10 

p-y Curve Criteria 
tl = Soft Clay Criteria #3 = Stiff Clay Above Watertable 
#2 = Stiff Clay Below Watertable #4=Sand 
15 = Interp. Between Input Curves 16 = Vuggy Limestone 

A 1:DEF:Num 3 L : Move Cell - 
Ah-X-Exit? 

: Help - / : Edit Screen--- F8 : Continue 
Fl-Help 
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File Analysis Mult option ExAMPLE.IN2 

Editing Effective Unit Weight Information 

Point 

r 
: 

: 

; 

"9 
10 

Depth 
inches 

20.00 
80.00 80.00 

600.00 

Unit Weight 
lb/in3 

0.072 
0.072 
0.035 
0.035 

A l:DEF:Num 20.00000 

: Move Cell - ? : Help - / : Edit Screen- F8 : Continue . 
Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE.IN2 

Layer 
# 

I 

2' 

: 
5 

; 

ii 
10 

Depth C 
inches psi de:. 

ES0 
e 508 0f c 

20.00 13.900 0.00 0.0050 
80.00 13.900 0.00 0.0050 
80.00 0.000 30.00 0.0000 

200.00 0.000 30.00 0.0000 
200.00 5.560 0.00 0.0200 
260.00 5.560 0.00 0.0200 
260.00 20.800 0.00 0.0050 
404.00 20.800 0.00 0.0050 
404.00 2839.000 0.00 0.0010 
600.00 2839.000 0.00 0.0010 

Editing Shear Strength Information 

A 1:DEF:Num L 20.00000 

: Move Cell - ? : Help - / : Edit Screen F8 : Continue - 
Fl-Help Alt-X-Exit 
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File Analysis Mult 

Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading + 
Computation Control 
Output Tables 

Option 

1 

Fl-Help Alt-X-Exit 

File Analysis Mult Option EEAMPLE.INZ 

Editing Loading Information 

Distributed lateral loading (y/n) 7 . . . ..*...**.... 
Is loading cyclic (y/n) 

Y 
? . . . . . . . . . . . . . . . . . . . . . . . . . n 

Boundary condition code (ICBC) . . . . . . . . . . . . . . . . . . . . . 1 

I 

ii: 
= 1 for shear and moment 
= 2 for shear and slope 

KBC = 3 for shear and rotational restraint 
ICBC = 4 for deflection and moment 

A 1:DEF:Lab y L : Move Cell - 
Alt-X-Exit? 

: Help - / : Edit Screen--- F8 : Continue I B 
Fl-Help 
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File Analysis Mult Option HXAMPLE.IN2 

Editing Distributed Loading on Pile 

Point Depth 

r 
inches 

Loading 
pounds/inches 

2 0.00 50.00 
3 10.00 100.00 
4 

2 
7 

8 
10 

A 1:DHF:Num 0.00000 

- : Move Cell - ? : Help - / : Edit Screen---- F8 : Continue I 
Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE.IN2 

Editing Pile-head Loading 

KOP Shear Moment Axial Load 
pounds in-lbs pounds 

1 50000.00 100000.000 100000.00 

KOP-0 if only a summary output for this load is to be printed 
=l if complete output is desired for this load 

A 1:DEF:Num 1 

: Move Cell - ? : Help - / : Edit Screen- FS : Continue I 
Fl-Help Alt-X-Exit 
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File Analysis Mult Option 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu 

Fl-Help Alt-X-Exit 

File Analysis Mult Option EXAMPLE.INZ 

Maximum number of iterations allowed for analysis 
Tolerance on solution convergence, inches 

: 100 
: 

Value of deflection considered to be excessive, inches 
0.000010 

Computation using internal-generated cracked/untracked III: N 
360.0000 

1 

A 1:DEF:Num 100 

: Move Cell - 
Fl-Help Alt-X-Exit? 

: Help - / : Edit Screen- FE : Continue I 
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File Analysis Mult Option 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables4 
Main Menu 

Fl-Help Alt-X-Exit 

File Analysis Mult Option B:EXAMPLE.IN? 

Output Printing Options 

*** Lateral Load Analysis *** 

Printing Increment (1 for every node, 2 for every other node, etc) 2 
Print deflection, moment, shear over full length of pile (y/n) Y 
Print p-y curves for verification Y 

iA 1:DEF:Num 2 

1 : Move Cell - ? : Help - / : Edit Screen- F8 : Continue - 
Fl-Help Alt-X-Exit 
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File Analysis Mult Option B:EXAMPLE.INZ 

Enter depths for which p-y curves are to be calculated for verification: 

Point Depth inches 

1 
2 

60.00 

3 
120.00 
240.00 

4 360.00 
5 

4 
8 
9 

10 

A 1:DEF:Num L 60.00000 

: Move Cell - 3 : Help - / 
Fl-Help 

: Edit Screen--- F8 
Alt-X-Exit 

: Continue - 

File Analysis Mult 

Title 
Pile Properties 
Soil Properties 
Lateral p-y Data 
Data for Loading 
Computation Control 
Output Tables 
Main Menu+- 

Option 

Fl-Help Alt-X-Exit 
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File + Analysis Mult Option 

I C624EDIT 2.0, Edit Variables: I 
This program is a preprocessor developed especially for users 
for preparation of input for the computer program COM624P. The 
main menu for this program is displayed as a bar at the top 
row of the screen. The main menu has .four choices: FILE, 
ANALYSIS, MULT, and OPTION. 

The selection of the FILE menu allows the user to access a pull- 
down menu for file operations such as reading in an existing file, 
creating a new data file, checking files in the directory, and 
similar operations. The sele tion of the ANALYSIS menu allows the 
user to enter required data f 1 r computing the response of the pile 
and soil, such as distributions of deflebtion, bending moment, 
shear, and soil resistance as a function of length along the pile. 
The selection of the MULT menu allows the user to enter data 
of a selected pile siee .for computing the ultimate bending,moment 
and other design-related information. 
The OPTION menu is used for screen setting and it may not be needed 
'for most computer systems. 

I 
Fl-Help Alt-X-Exit 

1 Fl-Help Alt-X-Exit 

File Analysis 

Read 
New 
Save - -c Directory 
Change dir 
Quit to DOS 
Main Menu 

Mult Option 
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File Analysis Mult Option B:?ZXAMPLE.IN2 

“2g-j 

save File Name 
EXAMPLE.INZ 

Main Menu 1 

Fl-Help Alt-X-Exit 
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OUTPUT RESULTS FOR EXAMPLE 2 
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EXAMPLE 2 CONCRETE PILES IN LAYERED SOIL WITH DISTRIBUTED LOADS 

UNITS--ENGL 

**********************************t**************************** 
PILE DEFLECTION, BENDING MOMENT, SHEAR & SOIL RESISTANCE 
*************************************************~*********~~ 

INPUT INFORMATION 
********************************* 

DISTRIBUTED LOAD CURVE 3 POINTS 
X,IN LOAD,LBS/IN 

.oo .500E+02 
10.00 .lOOE+03 
20.00 .200E+03 

THE LOADING IS STATIC 

PILE GEOMETRY AND PROPERTIES 

PILE LENGTH = 500.00 IN 
MODULUS OF ELASTICITY OF PILE = .310E+04 KIP/IN**2 

2 SECTION(S) 

X DIAMETER MOMENT OF 
INERTIA 

IN IN IN**4 IN**2 
.oo 

36.000 .8253+05 .108E*04 
300.00 

36.000 .6153+05 .10m+04 
500.00 

SOILS INFORMATION 

X-COORDINATE AT THE GROUND SURFACE = 20.00 IN 
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